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C H A P T E R  1  
 

Introduction 

 
Welcome to Visual Specs, a user-friendly software for analysis of astro-CCD spectral images in a 
Microsoft Windows environment. 

The Visual Specs software gives you a powerful and extensive toolbox for processing spectral data.  

Visual spec is not an image processing software neither an acquisition software. It assumes that the 
input data is a 2D image of a spectrum, with all the pre-processings complete (Bias, dark, flat, 
registration and stacking)  To perform these processings the user will need to use an image 
processing like the freeware IRIS, from Christian Buil. 

Using Visual Specs you can fully exploit your spectral images. 

• Creating spectral profile files from 2D  astronomical images with either automatic or manual 
extraction of the spectral profile – Format supported are the native format of Iris software and 
fits for black and white images 

• Wavelength calibration 

• Specific processing: extraction of continuum, correction of instrumental response, filtering, 
composition 

• Analysis and quantification: calculation of full width at half-maximum, signal-to-noise ratio, 
calculation of equivalent line width 

• Comparison of profiles: superposition, recalculation in wavelength, animation, exporting to 
*.bmp or text-compatible tables 

• Identification of chemical elements by referring to a database of wavelengths per atomic 
elements 

• Access to a library of standard spectra from different spectral types 

• If you have Excel, search for the spectral type of a star in the Bright Star Catalog 

• Export into fits format for professional database BeSS 

• Productivity tools like assistants and scripts 

• Window style User interface for external freeware: graphics (gnuplot), spectral modelling 
(spectrum), internet link to CDS professional database 

 
This first chapter shows how to install Visual Specs on your computer, introduces other sections of 
the document, and describes some fundamental processing of spectral analysis.   
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Installation 
 

Visual Spec uses the standard Windows installation method. 

Before installation 
 

Before installing Visual Specs, ensure that your computer meets the minimum configuration 
required. 

Verifying hardware and system compatibility 
 

To run Visual Specs you should have a certain hardware and system configuration installed on your 
computer.  The system configuration includes: 

• Windows 2000, XP, Vista (for W98 see website)  

• Optional: Microsoft Excel for exporting data in Excel format and for access to the Bright Star 
Catalog 

• Internet connection for direct access to professional database like the BeSS Be Star and Simbad 
atlas. 

• Does not support multibyte language like Korean, Japanese, chinese – only westrern window 
regional settings 

Installing Visual Spec 
To install Visual Spec, launch “Setup.exe”.  Follow the instructions given during installation. 

In addition to the executable, Vspec will install: 

Element.txt 
Database of atomic lines for which the atomic number is lower than that of Iron 

Sun.txt   
Database of Sun lines  

Pic.xls 
Excel document for exporting image areas 

Brscat2.xls 
Bright Star Catalog in Excel format 

Help.pdf 
Help document in *.pdf format, readable using the free Acrobat reader software 
(www.adobe.com/acrobat) 

Libspec directory 
Contains standard spectra of different spectral types, from Pickles et.al. 

H20.dat 
ASCII File Intensity-wavelength of the earth atmosphere to eliminate atmospheric lines in spectral 
profile 

http://www.adobe.com/acrobat�
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Gnuplot package 
GnuPlot application files for graphics generation.This application is an open source application. 
Copyright 1986 - 1993, 1998, 2004   Thomas Williams, Colin Kelley. 

Spectrum package 
Sub directory Spectrum: Spectrum application from R.O. Gray to generate theoretical spectra based 
on stellar atmosphere model. Those models are in a sub-directory “models” 

BeSS_VO 
Empty directory for cache. It will contain the files which results from the query to the BeSS 
database on internet. 

How this manual is organized 
The chapters of this manual can be grouped as: 

• Chapter 1:   Introduction and installation 

• Chapters 2-4:   Basic concepts of Visual Spec 

• Chapter 5:   Spectral series – how to create, save-to-file, and modify spectra  

• Chapters 6-9:   Process and analyze the data 

Examples of applications 
On the Vspec site you can find a package with some examples. 

• Spectral images obtained of T60 from the Pic du Midi Observatory (France) with the “Bardin” 
spectrograph 

• Spectral images obtained by C.Buil and Morata's family 

• Spectral images sent by Jack Martin (UK) et Dale Mais (USA) 

Spectral Image Concepts 
Spectral imager processing consists in reducing then analyzing the spectrum of an object.  The input 
data of Visual spec is a 2D image which contins preferably only one spectrum, This software and 
manual will not describe how to acquire spectra and the image processings required to get the final 
2D spectrum images. The purpose of Visual Spec is to  process the spectral profile, reduced the data 
and analyze them. 

The spectral profile is a graph representing the intensity of the spectrum by pixel.  Starting from the 
spectral profile, one carries out the analysis.  The first operation consists of calibrating the profile in 
wavelength.  One can then carry out various operations of identification or correction. 
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Spectral Image 

 
A spectral image of an object usually contains: 

• The spectrum of the object 

• The background 

• Some surrounding stars in the case of a assembly “without slit”. 

 

 

 
The spectrum of an object should be extended along the horizontal axis.  It is strongly recommended 
to align the spectral lines with columns of the CCD matrix before acquisition.  Otherwise, one can 
rearrange the image by rotating, using an appropriate image-processing software.  

 
The spectrum of an object is generally distributed among several image lines.  This vertical 
dispersion is eliminated with the conversion into  a spectral profile. 

The background of an image contains spectra of the background of the object, most often the 
background of sky.  If lines are present, one can obtain their spectral profile and subtract it from the 
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spectral profile of the object, or does the operation using a n image processing software which 
includes spectral 2D processings, like Iris.  

Visual Spec assumes that the blue region of the spectrum is on the left and the red part on the right. 

The spectral profil 
The spectral profile is the distribution of luminous intensity as a function of “color”, or wavelength.  
It is presented in the form of a series of data points (intensity per pixel) and can be represented as a 
curve, each pixel being thereby associated with a wavelength by calibration. 

The transformation of a spectral image into a spectral profile is accomplished by “binning”, or 
summing line-by-line the spectral image of the object.  This operation increases the signal-to-noise 
ratio and condenses the spectral image into an intensity curve called a series, which can then be 
saved in a document called a profile document.   

A profile document includes several spectral series intensity curves so-called series which  can be 
saved in one profile document under the “.spc” proprietary format. 

Distribution of intensity by pixel is decomposition of the luminous intensity by wavelength.  One 
can then associate each intensity value, calibrated by pixel, with a wavelength and establish a law of 
dispersion.  Vsiual spec will handle non-linear calibration law and will convert it into a linear one on 
the observed spectral region A pixel represents the same quantity of wavelength no matter what its 
position.  To establish the  “Pixel-Wavelength” relationship, at least two points of reference must be 
defined, or one point and the dispersion if it is already known. 

tdztau-1.pic 

 
adztau-2.pic 

 
        660.4 nm 653.8 nm 

The association of a pixel to a wavelength is accomplished with the help of these lines of reference.  
To do this, one identifies two points in the spectrum corresponding to lines of known wavelength, 
then by applying interpolation one can continue with the calibration itself. 

The calibration is done using a spectrum called the reference; this spectrum can be one of a known 
set (calibration lamps) or could be spectrum of the object if its lines are easily identifiable although 
this latter method is less precise. 
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Spectral Analysis 
Spectral analysis of an object includes several categories of operations 

• Identification of the lines 

• Modification of the spectral response, scaling, correction of the continuum, Planck’s Law, 
atmosphere lines correction, atmospheric extinction, heliocentric speed correction 

• Measurements:  center of the line, equivalent width, full width at half-maximum 

Identification of the lines is done based on their wavelengths.  Each chemical element produces a 
unique set of lines (its spectrum) of wavelengths, of which each line is the result of an atomic 
transition between two energy levels characteristic of the atom under consideration.  One who is 
interested can consult the literature for an explanation of the physics of this phenomenon. 

The resolution of a spectrum is defined as the smallest domain of wavelength associated with a 
pixel.  An insufficient resolution impedes determination of the chemical elements having lines in 
this area.  To help identify lines, Visual Spec includes a database of spectral lines between 3000 and 
11000 angstroms. 

The intensity of a spectrum is affected by: 

• The spectral response of the CCD 

• Its own continuum, distribution of energy into wavelength as a function of temperature 
(Planck’s Law) 

• Atmospheric extinction 

One can correct for the spectral response of a CCD by using the spectrum of one of the library of 
standard spectral type spectra included with Visual Specs.  Comparing experimental intensity with 
standard normalized intensity of same spectral type provides the curve of  the spectral sensitivity of 
the equipment used.  This response curve can then be used for correcting spectra obtained under the 
same conditions of observation. 

To determine the spectral type of a star, the Bright Star Catalog database is available if one has 
previously installed Excel. Or the user can connect to the CDS internet database to get the star 
spectral type. 

One can also simply carry out the elimination of the continuum by approximating the continuum of 
the profile by a continuous law.  This operation yields a “flat” spectrum despite the response of the 
CCD, but also eliminates the physical continuum of the object which is a function of the temperature 
of the object (Planck’s Law). 

To obtain the “Planck profile” of an object the instrumental response as to be carried out and the 
continuum shall not be removed. 

Additional processing can be carried out like: atmospheric extinction correction, earth Doppler shift 
correction (heliocentric correction), atmosphere lines elimination 

Finally, it is always possible to normalize or "scale" a spectrum with respect to a spectral area that 
contains no lines.  Normalization removes variations in intensity due to different exposure times by 
calculating only the relative intensity compared to the same spectral domain.  This simple operation 
is often sufficient for profiles having little variation of continuum during extended spectral 
recording. 

The following measurements can be made on spectral lines: 
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• Center of the line 

• Full width at half-maximum 

• Equivalent width 

The center of the line is determined with precision by calculating the barycenter.  It is important to 
be careful with the selection of the line to avoid introducing error into the measurement. 

The Full Width at Half Maximum (FWMH) of a line can be used to determine the speed of 
expansion or rotation of the body under observation.  It can also be used as an indication of the 
resolution of the instrument, if it is taken on a reference line of a body under known physical 
conditions (calibrated lamp). 

The equivalent width of a spectral line is a spectroscopic measurement that can characterize the 
“power” of the line.  This measurement allows one to precisely follow the development of a line 
over the course of time for the same object as it presents variations. 

Must-do spectral processings 
The spectral processing can be splitted into 2 sets: 

• Processings which are instrumental or observational dependant: they cannot be carried out 
without addtional data linked to the night of observation or linked to the instrument. Those 
processings are the mandatory set of processings which has to be applied before sharing data 
with community, like uploading the spectrum into the professional database Bess. 

• Processing or data reduction which can be independently conducted by a user which has not 
acquire the spectra. 

 Intrumental dependant processings 
• Wavelength calibration 

• Instrumental response curve correction 

In addtion to those minimum processing, for sharing data the user shall record the time of 
observation, the celestial coordinates or the name of the object. Additional informations for 
scientific usage may be also required as described in the BeSS format conversion section. 

 



Manuel de Référence Your first spectral profile 
 
 
 

Visual  Spec Launching Visual Specs | 15 
 

C H A P T E R  2  

Your first spectral profile 

 

 
It will take you several minutes to obtain your first spectral profile from a pre-processed digital 
image.  You open a *.pic or *.fit file, the image will be displayed, you can adjust the thresholds of 
visualization and obtain information about the intensity of the pixels.  Then, you extract and 
visualize the spectral profile, which you can save as a “Profil” document.  You continue by 
preparing wavelength calibration based on a reference image, and you finish by filling in the 
document header. 

This chapter provides an overview of these operations, describes the necessary documents and 
knowledge you will need to use Visual Specs 

Examples 
You can download the set of examples from the web site.. 

 An example from a spectrum obtained as Spectrum of T60, Picture of the Day of the star Dzeta Tau, 
is included with the application.  You can find it in the application folders.  It consists of: 

Dztau-1.pic – spectral image 

ADztau-2.pic – reference spectral image, Argon lamp 

Dztau-1.spc – spectral profile calibrated in wavelength 

Launching Visual Specs 
To execute Visual Specs, double-click on the Visual Specs icon 

 

Visual Specs files 
The Visual Spec application manages two types of documents through Windows windows: 

Images: read-only files in *.pic or *.fits format, black and white 2D image. 

Profiles: files in *.spc format, created only from image files by the Visual Specs application; an 
ASCII file containing one or more spectral intensity curves called series – or a fits 1D file format 
(one spectrum, linear dispersion). 

VSpec can also read simple “ascii” files as “.dat” format. The file shall contain two columns. First 
one shall be the wavelength column, with values equally spaced (linear). The second column will 
contain the intensity values. 
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Manipulation of Visual Spec document windows follows usual Microsoft Windows standards.  One 
will find the traditional classical window menus for documents in an application. 

Image Documents 
The image document allows one to view the image file.  The intensities of the pixels of a CCD 
image are displayed using 256-level grayscale, with thresholds that can be set by the user.   

The image document has a fixed size corresponding to the size of the binary image. 

Profil Document  
The profile document allows one to view the profile file, which contains the spectrum.  Spectra are 
represented in the form of a graphical curve, called a series, of which the Y values are the intensity 
of the spectrum as a function of X, X being either the pixel number or the wavelength once the 
spectrum has been calibrated in wavelength. 

A Profile document can contain, in addition to the spectra of an object, some associated series such 
as the result of a division, an instrumental response, a reference spectrum, all associated with the 
same calibration in wavelength. 

 
The document profil has an adjustable size. 

It is recommended to associate a document with an object spectrum, even though the document may 
contain associated series serving as references or intermediate results of processing. 

Note: 
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Informations windows 
A certain number of windows are created during execution of the application but are not considered 
to be documents; unless otherwise indicated these windows cannot be saved. 

Graphic window for quickly showing a cut from the intensity of a line image 

Information windows containing results of different calculations done on profiles - the contents of 
these windows can be saved in the format of a text file “infos.txt”. 

Image window of a synthesized spectrum 

Console window for entering command-line commands 

Other documents generated by the application 
Three other sub-types of documents may be generated but are not directly generated by the 
application: 

Excel file, containing the values of the pixels of a sub-image 

Bitmap file *.bmp: graphical copy of a profile file 

Text file *.txt: exported values from a profile file, following formatting rules for an Excel table so 
the file can be read using this application 

Activation of a document 
To make a document active, click one time within the document, preferably in the bar at the top of 
the window. 

Selection of a profil region 
To select a region of a profile, the region can be a spectral line or a section of the continuum: 

• Activate the document where the profile is 

• Activate the serie which contains the profile where the selection has to be done (by clicking on 
the profile curve or slecting the serie name in the drop-down list of the toolbar – see the serie 
section) 

• Click with mouse left button at the beginning of the desire selection 

• Move the mouse while maintaining the button pressed 

• End the selection at the desired location by releasing the mouse button 

Interface elements 
 

The Visual Specs interface is in the Microsoft Windows style, with menus, document windows, and 
toolbars. 

Four toolbars give access to functions depending on the type of document or the operations chosen 
by the operator. 

Main toolbar: always present 
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The text area contains information relating to the position of the cursor, depending on the type of 
document displayed 

Image toolbar: appears only when an Image document is on the screen 

 

 
 

Profile toolbar: appears only when a Profile image is on the screen 

 

 
 

• Calibration toolbar: appears only when the operator wants to perform a calibration in 
wavelength of a profile. 

 

 
 
 

• Continuum toolbar: appears only when the operator wants to perform an approximation of the 
continuum 

 

 

Preferences 
Visual Specs permits the user to save a certain number of configuration parameters for Visual Specs. 

The configuration parameters for Visual Specs are: 

• Default folder for image and profile files 
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• Reference wavelength of spectral lines for calibrating in wavelength 

• Spectral area for continuum calculation  

• Default comments 

• Geographic position  

• Language selection: French or English 

• Path to get acces to external software SPECTRUM  

• Atmospheric line file setting 

• Export to fits format for BeSS database pre-filled keywords 

 
These configuration parameters are used by Visual Specs while it executes.  They are saved in the 
Registry. 

To access them, click on the Options menu and choose Preferences. 

Preferences dialog box 

 

Default working directory 
Select the folder to be the default folder for the “open image” and “open profiles” commands. 

Select the default type of the Image file. You have the choice between the standard "fits" format and 
the proprietary format "pic" of the software Iris/Pisco of C.Buil. 

Select the default type of the profile file. You have the choice between the standard "fits" format and 
the proprietary format "spc" of Visual Spec. 
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Wavelength of spectral reference lines 

 
Wavelengths are in angstroms.  Two reference wavelengths are needed to correctly calibrate the 
spectral profile using a linear law. 

The wavelength “Line 1” will be used to correspond the barycenter of the line selected within the 
frame during the Calibrate mode of the Spectrometry menu when one clicks on the “Raie1” 
(“Line1”) button. 

The wavelength “Line 2” will be used to correspond the barycenter of the line selected within the 
frame during the Calibrate mode of the Spectrometry menu when one clicks on the “Raie2” 
(“Line2”) button. 

The “List” listbox contains a list of the common reference lines. 

• Select from the listbox the reference wavelength to be a reference for the calibration 

• Click on the button “<<” next to the corresponding textbox to automatically fill in the value 

To add an entry to the listbox, click on the button “>>” and the value in the corresponding textbox 
will be added to the list. 

These additions to the list are not saved.  When the program is launched, only the values listed in the 
appendix will be present. 

The Auto Selection line width is a line width parameter in pixels which shall correspond to the 
average width of the spectrum lines in pixel. It is used in automatic algorithms to ease the detection 
of a spectral line in specific function. 

 

Note: 
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Spectral area of calculation of continuum 

 
 

Wavelengths are in angstroms.  Two wavelengths delimit the area over which the average will be 
taken for calculating the relative intensity. 

During the normalization operation, the set of spectra will be divided by this average. 

This area should not contain spectral lines since it must represent the spectral continuum 

The directory icon button open the working directory to read a text file which can includes the 2 
wavelength separated by a coma as below: 

6600,6610 
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Default Comments 

 
The entered text is displayed in the comment area while editing the header of a “Profile” file, when 
one clicks on the button " Preset "in the header dialog box. 

Geographic position 
In some occasion, where very accurate computation is needed, it is required to know observation site 
coordinates. 

The coordinates shall be entered under the decimal format: dd.mmss 

In this version the altitude is not used. 

The UT value in the timing zone drop down list is used in the computation of the time of a sequence 
if the exposures have been acquired with a PC not set at UT time. 
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Language 
If you do not like the default language, you can change it in the tab "Intl" by clickqing in the 
language of your choice. 

This preference will not be applied until you quit and re-launch the application. 
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Link with SPECTRUM 
Spectrum software is a free software written by Richard Gray. It generated synthetic spectrum from 
diverses phisical parameters and stellar atmosphere model. To have Visual Spec automatically send 
parmaters to SPECTRUM and get displayed spectrum results, yo need to need to configure the 
directory path. 

 
 

Atmosphere 
To remove the atmospheric lines from an object spectrum, a file containing the wavelength and the 
intensity of the atmospheric lines shall be used. This file shall be present in the root directory of the 
Visual Spec application. 

If you have different atmospheric file, this tab allows you to select the one you want to use by 
default. 
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All the file having a .dat extension in the root directory of the application are listed here. Select the 
appropriate one. Visual Spec proposes a default file created by Christian Buil from various source of 
data. 

BeSS(1) 
This tab allows you to pre-filled key words used to fill the Fits header and BeSS additional key 
words. 
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• Observer: (Fit keyword) Name of the observer(s) – limited to 68 characters. Names shall be 
delimited by coma if mulitples. They shall correspond to the Bess alias of the observer profile 
when registered to BeSS. 

•  Instrument:  (BeSS fits keyword) Title of the instrumental configuration. It will allows the 
database to classify your spectrum. The instrumental profile shall refer to an existing profile in 
BeSS or at upload you will have to fill a new instrumental profil. 

• Site: (BeSS fits keyword) Observation site. Same as above for its declaration in BeSS.  

BeSS database do check the exact name of those keywords. So if one character or word is not 
exactly the same which is recognized by the database, a new profile will be prompted to you for 
filling. As it can be painful to keep track of the exact syntax of your configurations, Vspec offers 
you to use two text files to keep track of them. Two files are used: 

• List_instru.txt: Each line shall be instrumental configuration title. See the example below 

 

• List_site.txt: Each line shall be the name of your observation sites. See the example below 

•  

 
Lines of those file are displayed in the drop-down list. List Instru and List Obs. If the files do not 
exist or are empty, the drop-down list are empty. You will have to keep those files in the root 
directory of Vspec. 

 

BeSS(2) 
This additional tab is for BeSS keywords which described the method used for standard corrections 
in the fits header. 
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Each text field shall not include  more than 40 characters and shall not include special characters to 
be compatible with the fits standard. 

VisualSpec Help 
The on-line VisualSpec help file is in a *.pdf format, which necessitates installation of the Acrobat 
Reader.   

Acrobat Reader is available free and can be obtained via the Internet from www.adobe.com/acrobat. 

To access the help file, refer to the Acrobat Reader documentation. 

The help file Aide.pdf is also contained in the document Vspcman.doc available in the form of a 
Microsoft Word97 file. 

To access help on-line: 

• Click on the menu ?, and choose Help 

Verify that the file type .pdf is associated with the Acrobat Reader application to automatically read 
the file using this application. 

Anotated profiles 
A spectrum profile anotated is a profile where the lines are identified with their respective 
wavelength. 

To access the diagrams 

Click in the menu "?", subitem Diagrams 

The following annotated spectra are available – see in appendix the copy of these diagrams 

• Telluric lines 6470-6590 

Note: 

http://www.adobe.com/acrobat�
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• Telluric lines 6500-6600 

• Neon 3000-7000 

• Vega 3800-8000 

Steps for creating a profile 
Display an image 

Displaying an image is done by choosing Open Image from the File menu, then using the standard 
“open…” dialog. 

The size of the window will depend on the size of the binary image and cannot be changed. 

Dztau-1.pic 
Open the file Dztau-1.pic in the root folder of the application.  The image has been processed as is 
commonly done for a CCD image, offset, black, and the spectrum is horizontal 

aDztau-2.pic 
Open the file aDztau-2.pic in the root folder of the application.  The image is the spectrum in the 
same domain of wavelength obtained with an argon calibration lamp. 

 

Extract the spectral profile 
The creation of a spectral profile from an image is done by clicking on the “Object Binning’ button 

 of the “Image” toolbar. 

A new Profile window is created and the result of binning is displayed in the form of a spectral 
profile. 
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Spectral profile of the image aDztau-2.pic, reference spectrum for calibration: 

 

Dztau-1.spc 
Open the file Dztau-1.spc in the root folder of the application.  The profile was calibrated in 
wavelength.  Compare it with the spectrum that you have obtained from the raw image Dztau-1.pic 
and the image of the reference spectrum aDztau-2.pic. 

Fill in the Header 
The header of a profile file contains some useful information related to the exposure and the 
conditions of observations.  Some of these values, such as the exposure time, are needed for certain 
operations such as flux calibration. 
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File name 

Date and starting time of exposure:  they are updated automatically by the application during the 
creation of a spectral profile by binning. 

Date and finishing time of the exposure 

Duration of exposure:  it is entered automatically by the application during the creation of a spectral 
profile by binning. 

Alpha: right ascension of the object, entered by the operator.  Used to calculate the zenithal height of 
an object for correcting for atmospheric absorption and for heliocentric speed in accurate Doppler 
measurements. 

Delta: declination of the object, entered by the operator.  Used to calculate the zenithal height of an 
object for correcting for atmospheric extinction. It is used also in heliocentric speed correction for 
accurate doppler measurements. 

Comment: textbox.  There is a function for searching for “Profile” documents containing a specified 
search-string within these comments.  It is advisable to include, for example, the name of the star. 

Save the profile 
Save the profile document by using the File menu, then choose Save or Save As… 
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C H A P T E R  3  

Image 

 
 

Document 
 

The Image documents contains the spectral image to be analyzed.  These documents are used to 
create the Profile document that contains their spectral profile. 

 

Image Format 
 

The Image files accessible by this application are limited to format “.pic” generated by the program 
Pisco and Iris  © or “.fit”,".fts", ".fits" traditional FITS format. 

The thresholds of visualization by default are those that are entered in the header of the .pic or .fit 
file. 

 
If the automatically-provided thresholds from the header of the image do not give anticipated results, 
adjust the thresholds manually. 

 

Image Folder 
 

The default folder to contain “Image” files can be set in the “Preferences…” dialog box. 

 

Open and close an image 
 

Open an image 
 

To access the dialog box for opening an Image document: 

• Click on the menu File, choose Open Image 

Note: 



Manuel de Référence Image 
 
 
 

Visual  Spec Obtain information about the image | 32 
 

Or 

• Click on the “Open Image” button  in the main toolbar of the application. 

 
The standard Microsoft dialog box will be displayed.  It is possible to select several documents 
using the SHIFT or CTRL buttons. 

It is possible to select the image file format in the filter area of the dialog box: 

• Qmips (*.pic) 

• Fits (*.fit) 

 

Close an image 
 

To close an Image document: 

• Click on the File menu, chose Close 

Or 

• Click on the close symbol in the frame of the document window. 

To temporarily close a Image document, click on the “Minimize Window” symbol in the frame of 
the document window.  The minimized document will be placed at the lower left of the application.  

 

Search for a reference image 
 

In the case where a calibration lamp or other source of external calibration (standard lamp) is used, 
before or after each spectrum, a reference spectrum will have been created to calculate the law of 
dispersion of the set in the same configuration.   

If the user saves the reference image which is used for the wavelength calibration using the 
convention: name of image = prefix “a” + name of spectral image of the object, and if the reference 
image is in the same folder, this function will automatically find files corresponding to the criteria: 

• Name of active displayed image, with the prefix “a” 

To recover the reference images identified by the prefix “a”: 

• Click on the File menu and choose Find References… 

Example:  if the image “Dztau.pic” in the Image folder is active, the search function will select all 
files aDztau*.pic which are present in the Image folder. 

Obtain information about the image 
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Position of cursor 
 

The cursor placed within the image area takes the shape of a cross. 

The x,y position and the intensity of the image pixel under the cursor are indicated in the main 
toolbar of the application. 

Change the Thresholds 
The thresholds of an image, high threshold and low threshold, define the “contrast” of the rendering 
of the image, also called scale of visualization. 

All the pixels whose values are included between the low and high threshold are rendered using a 
256-value grayscale. 

A smaller scale augments the contrast of the image, but reduces the visualization of the total 
dynamics of the image. 

A larger scale diminishes the contrast of the image. 

To find the optimal thresholds: 

Search, by moving the cursor, for the maximum values of the image where a signal is present. 

Use a value slightly higher than this value as the high threshold. 

Search, by moving the cursor, for the minimum values of the image, values of the black areas of the 
image. 

Use a value slightly lower than this value as the low threshold. 

To increase contrast, gradually tighten the thresholds around the average value of the image. 

The thresholds are modifiable by manually entering values for “high threshold” and “low threshold” 
in the text area of the Image toolbar (directly editing) 

Or 

By using the cursor. 

Change the thresholds by direct editing 
 

The area for directly editing the rendering thresholds is located in the Image toolbar. 

To edit a threshold 

• Click in the edit area of the threshold 

• Enter a value between 0 and 32000 

• Click on the “apply threshold” buttons  so the value is accepted. 

One can return to the original thresholds of the Image file by clicking on the button “original 

thresholds”.  



Manuel de Référence Image 
 
 
 

Visual  Spec Select an image area | 34 
 

Change the thresholds by using the cursor 
 

To modify the thresholds using the cursor, move the mouse while holding the left mouse button. 

• Moving upward: the high threshold will be increased 

• Moving downward: the threshold will be decreased 

• Moving rightward: the low threshold will be increased 

• Moving leftward: the low threshold will be decreased 

The new thresholds are not applied until the mouse button is released. 

The thresholds are limited to values between –32000 and 32000, and the difference between the two 
thresholds cannot exceed 32000.  Visual Spec corrects them automatically. 

One can return to the original thresholds of the Image file by clicking on the button “Original 

threshold”.  

The mouse may move outside the document window. 

 

Select an image area 
Selecting of an image area is done by moving the mouse while holding the right mouse button. 

The image area selected can be used for either creation of a spectral profile or for exporting the 
values of the pixels to an Excel file. 

 
To make the selection indicator disappear, right-click on the image area without moving the mouse. 

 

Export to Excel 
The application can export a previously selected image area to Excel.  This function is not available 
if Excel has not been installed. 

• Select an image area 

• Click on the “Excel” button  

The values of the pixels are placed into an Excel file “Pictemp.xls”.  

If the image area is too large, the time needed for exporting can be significant.  The hourglass cursor 
will seem to disappear, but until the Excel application appears the transfer is still proceeding. 

When the export operation is completed, Excel will become active.  A worksheet containing the 
values of each pixel in the cells of the Excel document is created under the filename “picTemp.xls”. 

Note: 
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To return to Visual Specs, close Excel. 

Save the file PicTemp.xls under a different name if you don’t want to overwrite preceding values. Note: 
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C H A P T E R  4  

Profile 

 
 

Profile Document 
The Profile documents of the Visual Spec application contain one or more spectral intensity curves, 
called a series in the application.  They are the fundamental documents of the application with which 
most of the processing and analysis operations will be done. 

Profile Format 
It is valuable to make the distinction between the format of a *.spc file and a Profile document. 

The Profile document is the window of the application that allows one to visualize, process, and 
compare spectra.  A spectrum is a graphic visualization of intensity as a function of pixel number, or 
of wavelength after the spectrum is calibrated.  The graph of a spectrum in a profile document is 
represented by a spectral series.  These spectral series are graphic profiles constructed from a table 
containing: 

• The wavelength of the point or, if the series has not been calibrated, the sequence number of the 
pixel 

• The intensity at each point 

Each profile document has the capacity to contain four spectra or basic spectral series which are 
saved by the application, identified by the symbol  , and an unlimited number of “temporary” 
series, which are not saved, identified by the symbol  in the Select Series control box of  the 
Profile toolbar.  These spectra share the same spectral sampling. 

The files Profil.spc accessible to and created by this application are in “.spc” format, a proprietary 
format of Visual Spec but based on ASCII format. 

When saved as a “Profile” file, along with the four basic series are recorded: 

• the sequence number of each pixel 

• the wavelength in angström of each pixel 

• an index which invalidates the value of the pixel of the profile if the index value is –1 
(otherwise the index value is 0) 
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Profile Folder 
The default folder containing the Profile files in format *.spc is defined using the “Preferences…” 
dialog box. 

Create and open a profile 
Create a profile 

The creation of a profile is always done from an image, by the operation of binning. 

Binning is a simple summation by column of the pixels selected within the image area.  It increases 
the quality of the spectrum as compared to a simple extraction by line of the image. 

Two types of binning are suggested: 

• Object binning: summation of lines containing the spectral signal, by clicking on the button 

 of the Image toolbar. 

• Reference binning: summation of a sub-set of lines, by clicking on the button of the Image 
toolbar. This reference notion is useful when working with calibration lamp as a spectral 
reference. 

It is advisable to rectify any spectral image having tilted lines using Qmips 32. It is also required 
that the spectrum beeing oriented in the direction from blue to red (from left to righ). 

Object binning 
The Objec binning creates a profile in the basic serie "Intensity" of profile document. The binning 
can be done according to two strategies: Automatic or by user zone selection. In this last case, two 
methods are proposed to select the zone before clicking the binning button. 

Automatic Binning 
The automatic binning do not requires user actions. It extracts the lines of the iahe which contains 
the spectral signal signal and add them. The algorithm of lines selection is based on the mean signal 
comparison to the added noise. If the signal level is superior to the added noise then the lne is added. 
In the contrary, the line is not added as it probably contains only sky background. This algorithm 
can added not necessarily contiguous. 

The binning constraint is that no other signal than the one from the spectrum or its background shall 
be present in the image. If another spectrum or a star are present, the algorithm will not make any 
difference and will add the high signal lines whether it belongs to the spectrum or not. 

Semi-manual binning 
The semi-manual binning allows the user to display a pre-defined box to define the binning zone. 
The box extend on the entire width of the image. The user can move the box up and down and 
change the heigth. 

The box zone is displayed by clicking on the button the  button of the Image toolbar.  It is then 
possible to move the area vertically using the cursor. 

Note: 



Manuel de Référence Profile 
 
 
 

Visual  Spec Create and open a profile | 38 
 

• Vertical move of the entire box: put the cursor over the binning box. The cursor looks like a 
cross. Click and drag by hitting the mouse left button. 

 

• Heigth modification: put the cursor on the upper border. Click and change frame heigth by 
hitting the mouse left button. 

 
The upper border position (Y) and the box heigth (H) are displayed in the lower right corner of 
Vspec. This allows a reproducible positioning of the binning from image to image if required. 

 

Manual binning 
If only a small zone contains the spectrum, it is more easy and fast to do the direct  selection using 
the mouse.  

• Select the zone by hitting the right mouse button (he left button is used to modify contrast and 
brighness) and drag around the desired zone. 

 

Reference binning 
Reference binning is done by a simple summation by column on the total image . 

Reference binning generates a basic “Ref1” series in the Profile document. 

A manual or semi-manual selection is possible before starting the binning using the "reference 

binning" button  

Warning: a profil file shall always contains a valid profile in the "intensity" serie. If you do only a 
"reference binning" Vspec will not allow you to save the document. You shall have perform an 
"Object binning" or moved the "ref" serie into the "intensity". See the move a serie section. 

Creation of a profile 
When the binning is completed the profil is created. Several options are available depending whether 
a Profile document is already open. 

Note: 
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If no profile document is displayed a new profile document is created.  It is positioned under the 
Image window and takes the name of the image with the *.spc extension. 

If a Profile document is already present, a dialog box is displayed: 

• If the operator answers “yes” to the question “Do you want to recover the file from existing and 
lose your changes?” then the binning will replace the preceding values.   

• If the operator answers “no” then a new Profile document will be created with the same name as 
the active profile document to which a letter “n” is appended. 

Open a profile 
To open a Profile document 

• Click on the File menu and choose Open Profile 

Or 

• Click on the “Open profile” button  of the main toolbar of the application. 

“Open Profile…”  dialog box 

 
• Select the disk 

• Select the folder 

• Select the document type among three options: 

- Spc format: original format inherited from A.Klotz software for compatibility 

- Dat format: text format with two columns (wavelength and intensity) and no header 

- Fits format: the one for spectro with multiple axis 

- UVS file format: from the the UVES database from ESO 

- All: will display spc, dat, fit files. 

Once the file downloaded from the ESO database, make sure it has the .uvs extension and not any 
.txt extension. 

 

Note: 
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• Select if a Processing filter shall be applied on the processing postfix as defined by Christian 
Buil on his site. Those postfixes are used in some assistants of Vspec. 

• Select the document in the *.spc file list presented 

- Select a continuous set of files by holding the SHIFT key 

- Select a non-continuous set of files by holding the CTRL key 

- When a file is selected, the information contained in the file header is displayed in the fields 
to the right of the folder list. 

• Click on the Cancel button to cancel the operation. 

• Click on the OK button to close the dialog box and display the file. 

This dialog box can be resized. When a profile document is opened and active its name is displayed 
in the bottom status bar. 

 

Drag and Drop 
You can also open one or multiple profile documents by simply dragging the fits or spc files from 
Windows Explorer. 

Open file with same name but from another directory 
When a file with the same name than a file already opened but from a different directory is opened, 
the profile window is displayed with an index added to the file name in the caption section. 

 
You can verify from wich directory is coming from in the status bar, at the bottom of the application 

 

Search for a profile 
The Search function allows one to find the set of files in a set of folders, whose “comments” header 
field contains the search-string specified in the search criteria area (see section “Fill in the header”). 

To search for a Profile document 

• Click on the File menu, choose Find… 

Or 

• Click on the Find button  of the main toolbar of the application 
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“Search…” dialog box 

 

• Edit the search criteria: in the search string, the character “*” replaces a set of undefined 
characters 

• Select the root folder 

• If the “Explore all subdirectories" checkbox is chosen, the set of folders under the root folder 
will be included in the search 

• To clear the search criteria and start a new search, click the “New” button 

• Click the “Find” button.  The list of files whose ‘comment’ field corresponds to the search 
criteria will be displayed at the right 

- Click on a folder in the list; the contents of the file's comment field will be displayed below 
the list 

- Press the DEL key on the keyboard; the file will be removed from the list 

• Click "Open" to close the dialog box and open the set of files contained in the list 

- If the “Normalize” checkbox is checked, upon opening the “Intensity” series will contain the 
normalized spectral profile starting from the continuum area that has been preset in the 
“Preferences…” dialog box.   

- If the “FB3 filter” checkbox is checked, upon opening the “Intensity” series will contain the 
spectral profile filtered by a third-order low-pass filter. 

- If both boxes are checked, filtering is done after normalization. 

• Click on the Cancel button to cancel the operation. 

• Click on the Stop button to stop search operation.

Open zip files 
You can drag and drop zip files on the yellow section of Visual Spec.  
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If the zip files contains files with format compatible with Vspec: fits, spc they will be automatically 
opened in the application. 

This feature is specifically appropriate to open files downloaded from the BeSS database. 

To run this function you need to have the dll vbuzip10.dll in the system32 directory 

VisualSpec Explorer 
Visual Spec has another profile files opening interface in Windows Explorer style to manage and 
visualize with thumbnails the profile files. 

The supported formats are the native format “.spc » but alos fits 1D files ((1D, V0 table)  and *.dat 

To launch the new interface, click on the button in the principal toolbar. 

 
A window of Explorer type will open in Visual Spec.  

 
 

• The first top left section is the directories treeview.  

• The second  top right section will display the thumbnails. 

• The bottom left section will display information from the file selected header. 

• The bottom right section will display a graphic with graduated axis of the selected file. 

Reach a directory which contains profile files by clicking on the nodes to develop the trees. 
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We can directly reach the default working directory defined in the preferences of Visual Spec by 

clicking on the icon   of the top toolbar.  

Click on a thumbnail to display the information from the header and the graphic. The header 
information will not exist for a .dat file as it does not have any header. 

To stop the generation of the thumbnails in a directory, click on the button  

 

Copy – move – delete  
To get access to the contextual menu, select a thumbnail and make a right click with the mouse. 

Pour accéder au menu contextuel,  sélectionner un fichier et faire un click droit avec la souris. 

• Open with Visual Spec – this menu item will directly open the file in Visual Spec application.  

• Copy – copy the file, to paste it in another directory. 

• Paste – select the destination directory and paste it  

• Delete – delete the file on the hard disk. Ask for confirmation.  

The following short-cuts are available: 

To move a file from one directory to another one, click on the thumbnail with the left mouse button 
and drag  it to the destination directory in the treeview section.  

To copy a file from one directory to another, click on the thumbnail as for a move but maintain the 
Ctrl key pressed as well. 
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To delete a file, use the “Del” key 

Filter – search 
There are three filters based on the file formats: *.dat, *.fit, *.spc which can be enabled with the 
buttons in the top toolbar. 

 
An enabled icon means that the format is included. A grey icon means the format, here the .dat 
format is excluded from the display. 

Search based on free criteria in file name can also be done, on the name of the file if the drop down 

menu  is selected. 

 
Wildcard characters are indicated by « * » - to run the search click on the icon with the mag glass. 

To explore sub-directories, click on the icon   . The background of the thumbnails section will 
become blue if it shows search results.  

If the menu  is selected, the search will be done on the keyword OBJNAME in the fits 
header.  In this case, only if the object name exactly matchs the search string the file will be 
considered. No "*" character is permitted. 

Sorting 
The files are sorted by alphabetical order. 

To modify the criteria of sorting, click on the menu  to apply a sorting by date or object 
name, only for fits files. 

Editing 
You can edit the header of the file in the file info section. 
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Click on the icon  to turn into the edit mode 

 

The editable fields are in blue – when all the changes are made, click on the save icon  or undo 

the change with no saving with the undo icon  

Close and Save a profile 
Close a profile 
To completely close a Profile document 

• Click on the File menu, choose Close 

Or 

• Click on the close symbol of the document window frame 

To temporarily close a Profile document, click on the minimize symbol of the document window 
frame.  The minimized document will be placed at the lower left of the application. 

To close all the Profile documents: 

• Click on the File menu, choose "Close all" 

If a document was modified since it was last saved, a confirmation dialog is displayed. 

Save a profile 
To save a Profile document 

• Click on the File menu, choose "Save…" 

Or 

• Click on the button    in the principal toolbar 
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The .spc file will be saved  in the working directory. 

If the file was modified, a confirmation dialog is displayed. 

Save under a different name 
To save a Profile document under a different name 

• Click on the File menu, choose "Save As…" 

The “Profile Save As…” dialog box will be displayed 

This is a standard Microsoft Windows dialog box. 

If the file already exists, a notification will be displayed to the screen. 

You can save the file under the dat format, change the type of the file in the standard dialog box 

The spectral series 
A spectral series is a spectrum for which the intensity of each point is associated either with an order 
number for the point, or with the wavelength once the series is calibrated.  The wavelengths are 
regularly spaced, the interval defining the spectral sampling. 

Each Profile document contains four spectra or series, each having the same sampling.  In addition 
to the basic series "Intensity", one can save the reference spectrum in the series "Ref1", the relative 
spectral intensity compared to the continuum in "standardized" and a second reference spectrum in 
"Ref2". 

For the benefit of the application, one can create and superposition temporary series, but can only 
save them by using them to replace one of the four basic series.  These temporary series are created 
by the application after certain operations such as filtering, cut/paste, division, calculation of a 
Planck profile, addition of a chemical spectrum or one of the library of spectra.  A temporary series 
may not have the same spectral sampling as the base series. 

There is always one series active in a Profile document, this is the series whose name is displayed in 

the “series” listbox of the Profile toolbar.  

Display a series 
When a Profile document is opened, the series displayed and active by default is the “Intensity” 
series. 

To display a different series: 

• Use the cursor in the “series” listbox in the Profile toolbar to select the name of the new series 

The new series displayed will become the active series. 

To change the color of a series: 

• Use the cursor in the “color” listbox in the Profile toolbar to select the new color from the list of 
colors provided. 

To change the display mode to by-point of a series, click on the Format menu and choose Plot. 

Note: 
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To change the display mode to histogram of a series, click on the Format menu and choose 
Histoplot. 

To return the display mode to  by-line-segment, click on the Format menu and choose Line. A sub-
menu is available to change the thickness of the line. 

To clear the display, click on the “Erase graphic” button  of the Profile toolbar. 

Selecting a serie 
To select a new series: 

• Place the cursor in the area of the “series” listbox in the Profile toolbar and select the name of 
the new series 

Or 

• Place the cursor over the graphic of the new series and click.  When the cursor is correctly 
positioned, the cursor changes to arrow-shaped.  The newly selected series will flash one time. 

Or 

• Move from one active series to another in the series listbox of the profile document by pushing 
the Tab key or Shift-Tab key of the keyboard.  Each series in the list will in turn become active. 

Selecting a series makes it the “active” series; that is to say that its spectral profile is displayed and 
when one moves the cursor along the profile, the position, the wavelength, and the intensity of the 
pixel are displayed in the upper toolbar.  The spectral sampling is displayed in the area of the main 
toolbar: 

 
Many functions are performed on the active series. 

The name of the file, the date and the time of the file where the serie belongs is displayed in the 
bottom satus bar. This is useful after a copy/paste of a serie from another file to keep track of the 
informations. 

Cursor position 
This function applies to the active series. 

On a profile document, only the X position of the cursor is changeable.  The cursor takes the shape 
of a hand holding a red line. 

Each new position is displayed in the main toolbar: 

 

• the pixel number 

• the wavelength, if it was previously calibrated 

• the spectral intensity 

 

Note: 
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To temporarily display the “comments” field of the document header, left-click on the yellow border 
around the image and hold the left mouse button; the comments will appear in a yellow rectangle at 
the cursor position.  It will disappear when the mouse button is released. 

Selecting a spectral area 
This operation applies to the active series. 

To select a spectral area: 

• Position the cursor at the start of the area to be selected 

• Drag the mouse holding the left mouse button 

• Release the button at the end of the area to be selected.  The selected area is framed by a gray 
dotted rectangle. 

Selecting a spectral area defines: 

• The spectral area to enlarge 

• The spectral domain on which calculations will be effective 

• The spectral domain of the database of wavelengths 

The zone of selection in the toolbar displays: the starting wavelength of the selection, the ending 
wavelength and the distance bewteen the two 

 

Spectral calibration 
Spectral calibration consists of establishing the dispersion relationship of Pixel to Wavelength of the 
profile.  Without this operation, it is impossible to analyze the results obtained. 

To establish the Pixel-wavelength relationship, several methods are available, the most precise using 
empirical reference spectra based only on instrumentation parameters defined by the user. 

To calculate the law of dispersion, Visual Spec assumes that the law is linear.  Whatever the domain 
of wavelength, the spectrum always has the same calibration. 

 

λλ  336600nnmm 776600nnmm

1 2 3   4  5   6   7…ppiixxeell  

Pixel n°5  raie λ=360nm 
Pixel n°638 raie λ=760nm 
 

(638-5) = Echx * (760-360) 
Echx= 400 / 633 
Echx= 0.632 nm  

Note: 
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A database of wavelengths of simple elements is available to help in identifying the lines. 

 
It is not always necessary to calibrate a spectrum in wavelength to identify some simple lines, such 
as the Balmer lines of hydrogen.  But this operation is needed to make possible the corrections, 
calculations and comparisons of the spectral processing  

 

Calibration using reference 
To calibrate a spectrum in wavelength, one uses a Reference spectrum.  This spectrum should 
contain one or two spectral lines of which the wavelength is previously known. 

This reference spectrum can come from: 

• A calibration lamp, standard lamp, or lamp of known composition such as argon 

• A star of which one knows the lines, and whose spectrum was obtained under the same 
experimental conditions 

• The spectrum itself, if it contains identifiable characteristic lines 

In each step of preliminary research for identification of reference lines, one can also perform a 
manual calibration from a simple reference point and a preliminary knowledge of the sampling of 
the device (see section “Calibration without reference”). 

Visual Spec requires that the reference spectrum be included in the profile document, in the form of 
the basic series “Ref1”. 

Add an external reference spectral profile 
To add a reference spectrum based on an image as the “Ref1” series: 

• Open the profile document of the spectrum to calibrate.  If the document does not exist, create 
the spectral profile as indicated in the section ‘Create a Profile’ in the chapter ‘Profile”. 

• Open the reference spectrum image 

• Click on the button “Reference Binning”.  Refer to the section ‘Create a Profile’ in the chapter 
‘Profile”. 

The reference spectral profile will be placed automatically in the series “Ref1” of the document.  
The four basic series share the same calibration. 

 

This function calculates the spectral profile from a simple sum  on the whole image or on a 
predefined zone (see section “Reference Binning”).  In the case of a spectrum obtained from a 
calibration lamp, the spectral image extends throughout the image, and binning with extraction is not 
useful. 

Note: 

Note: 
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Create a spectral reference profile from a star 
spectrum 
It is not always possible to have access to a reference spectrum whose elements are simple and 
known. 

One can, in certain cases, use the spectrum of a star obtained under the same experimental 
conditions and from which one can identify at least two lines with precision.  The spectrum of the 
object itself can thus be used for its own calibration. 

If one calibrates a spectrum based on its own lines, no calculation of Doppler shift is possible 
because it is not absolutely calibrated by an external reference. 

Some useful wavelengths of spectral lines are given in the appendix. 

To use the spectrum of an object itself for calibration: 

Select the “intensity” series of the document: 

• Click on the Edit menu, choose Replace 

Or 

• Click on the  button of the Profile toolbar.  The “Replace…” dialog box will be displayed 

 

• Click on “Reference 1” 

• Click on OK 

This operation permits duplication of the series “Intensity” to the series “Ref1”, which is the basic 
series used for calibration. 

It is possible to let the application do the job itself by clicking in the menu Spectrometry, sub menu 
Calibration. To the question "do you want to use the current serie ?", click on "yes" and the  
"Intensity" serie will be automatically copied in the "ref1" serie.  

 
It is also possible to copy a series from a different document, as long as the spectrum was obtained 
under the same experimental conditions… 

Note: 

Note: 
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Atmospheric lines 
If the spectrum contains atmospheric lines contained between 6875 and 7604 angstroms, these can 
be easily used to calibrate the spectrum because they are easily recognizable. 

 
02 Line 6875 angstroms 
H20 Line large line, can specify 6950 and 7250 angstroms 
02 Line 7590 angstroms 

 

 

Calibrate in wavelength with 2 lines 
Once the “Ref1” series is filled, activate “Calibration” mode. 

• Click on the Spectrometry menu, choose "Calibration 2 points…" 

Or 

• Click on the  button of the profile toolbar 

The Calibration toolbar will replace the Profile toolbar, and the active series will become the “Ref1” 
series. 

• Verify the reference wavelengths in the fields "raie 1" ("line 1") and "raie 2" ("line 2").  By 
default, they contain the values that were predefined in the “Preference” menu. 

• Edit these values directly if the default values are not OK. 

• Using the cursor, select the line that is identified as the first reference line.  Its wavelength will 
correspond to the absolute wavelength shown in the field “raie1” (“line1”). 

 

Note: 
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Calculation of the barycenter is very sensitive to the selected area.  It is recommended to select an 
area balanced around the minimum and maximum of the line, and not including other neighboring 
lines. 

 

• Select with the mouse the first line identified as the first reference line. Its wavelength will 
correspond to the absolute wavelength of the filed "line1" of the toolbar. At the end of the 
selection operation, a text box is displayed close to the selection. It contains by default the value 
of the "line2" field from the toolbar.  

 

• Type "Enter" from the keyboard to validate the value or double click with the cursor inside the 
text field. You can edit it before validating. Once validated, the barycenter position is displayed 
next to the line1 field in the toolbar. 

 

• Select the seconf line the same way, enter or keep the displayed value which corresponds now 
to the second line "line2" field. Validate 

• If you don not know by advance the exact wavelength of the identified line, you can be helped 
by the element database. Display the Element wavelength list and click on the wavelentgth you 
want to have it automatically displayed in the edit box. Just then type enter to have the value 
validated. See the section "Elements" later in the manual 

• Done ! – as long as you have validated the second wavelength, Visual Spec calibrate the sptrum, 
exits the calibration mode and display the "intensity" serie. 

The linear interpolation calculations will associate to each point in the series a wavelength based on 
the two reference points thus calibrated.  The X position of the cursor now gives access to the 
wavelength for each data point. 

To facilitate selection of the reference lines, it is possible to: 
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• Zoom on an area 

• Change the scale of the X and Y axes 

• Display the database of atomic lines (refer to the section “Elements”) 

At any time it is possible to quit Calibration mode and return to the “Line” menu by choosing the 
"Calibration…" sub-item on the "Spectronometry" menu. 

Calibration without reference 
Only one line is needed to calibrate the spectrum along with the knowledge of the linear dispersion 
of the spectrograph. 

This calibration operation is described by the section title.  It is not recommended.  It can, however, 
contribute to identification of the reference lines before performing the complete calibration, or 
make it possible to use the data in the absence of any access to a reference spectrum.   

This method is based on identifying only one point in the profile and on assuming the device 
sampling in angstroms per pixel. 

• Select the reference line 

• Click on the Spectrometry menu, choose "Calibration 1 line…" 

Or 

• Click on the button   of the profile toolbar 

 

 
A dialog box will appear.  The pixel position of the barycenter is indicated. 

In the Barycenter textbox, the barycenter of the selection area is automatically calculated and 
displayed.  To change this value, click in the textbox and enter the new value of the barycenter of the 
selection. 

• Enter in the “Wavelength” textbox the wavelength of the reference line 

• Enter in the “Sampling" textbox the assumed calibration of the device, in angstroms per pixel. 

• Click on the “Apply” button.  The X axis will immediately be calibrated in wavelength.  
Without clicking in the profile window, drag the mouse over the profile and verify the 
coherence of the wavelengths of the lines. 

Note: 
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• Redo the operation, adjusting the values, until a satisfactory result is obtained.  Do not change 
the selected line. 

• Click on the button “Close” to save the new calibration and close the dialog box. 

• Click on the button ““Cancel” to return to the original calibration. 

For this method it is not necessary to create a reference profile. 

To restart using a different line, exit by clicking on “cancel” then “close”. 

Application to an image containing a star. 
In case one has obtained a spectrum using an assembly without a slit, the star and its spectrum are 
present.  If one knows the dispersion of the device in angstroms per pixel, it is then possible to use 
the position of the star to calibrate its spectrum. 

Display the image containing the star and its spectrum. 

Perform Object Binning, or manual binning by framing.  The base series “Intensity” then contains 
the spectrum. 

 

 
 

1. Replace the base series “Ref1” with the series “Intensity” 

2. Select by framing the line which indicates the position of the star 

3. Click on the Spectrometry menu, select ““Define…” 

4. Enter 0 in the “wavelength” area; the dispersion will start from the star 

5. Enter the number of angstroms per pixel of the device in the “sampling” area 

6. Click on the “Apply” button 

7. Drag the mouse over the document; the wavelengths will be displayed in the main toolbar 

8. Change the value of calibration as needed 

9. To save the calibration, click on the button “Close” 

10. Select the useful area of the spectrum 

11. Click on the Edit menu, choose “Crop" 

12. Save the result 

Note: 
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Non linear calibration 
Non linear calibration is useful when the dispersion system used does not shift the wavelength of the 
same pixel-length quantity. Up to now, all the proposed method was assuming that each pixel was 
seeing the same wavelength quantity. 

To proceed with a non linear calibration, one can cut the spectrum into small pieces, small enougth 
to have the linear assumption beeign correct. 

Visual Spec proposes a more powerfull interpolation function on the entire spectrum based on a 
multiple reference lines identification. This function still permit the linear calibration if wanted. 

• Click on the menu Spectrométry, choose Calibration multi-lines 

Or 

• Click on the button   of the profile toolbar 

A dialog box appears to enter the reference wavelengths. 
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Dialog box non linear calibration 

 

• Select the first line by click-drag on the serie to calibrate. 

  

• A small text box appears close to the cursor. Enter the wavelength value of the line. Validate by 
hitting the Enter keyboard key. 

• Instead of entering data with keyboard, you can directly use the element database from Visual 
Spec. 

- For this, you need to have displayed the "Element" window and have selected the appropriate 
database. See the Element section later in this manual. 

- In the Element window, click on the line from you want to copy the wavelength 

- The value will automatically be set in the text box 
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- Click back on the text box and press Enter 

 

• In the dialog box, the wavelength table is filled with the wavelength and the position of the 
barycenter, along with a reference ID 

• Repeat the line identification operation for each known lines 

 

• Select the polynome degree 

• Click on the "Calcul" button. The interpolation of the wavelength law are displayed in the 
bottom of the dialogn box and the profile is calibrated. The profile is linearly re-sampled with a 
sampling factor close to the linear coefficient of the equation.  
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• If the number of lines is not enougth to match the inerpolation degree selected, the lower order 
is automatically selected and applied. 

Degree Minimum number 
of lines 

Interpolation equation 

Degree 1 2 lines lambda = ax + b     (x= cursor position) 

Degree 2 3 lines lambda = ax2 + bx + c 

Degree 3 4 lines ax3 +bx2 +cx +d 

Degree 4 5 lines ax4 +bx3+cx2+dx+e 

 

• The equation coefficient are displayed in the bottom frame 

Save an equation 
• To save the equation coefficient , click on the button "Save" in the Interpolation bottom section. 

A dialog box will appear to allow the user to enter the file name.  

 
The interpolation equation coefficients are mainly function of the dispersion system used. They do 
not vary from one spectrum to another if no change is made on the isntrumental configuration. Only 
the constant (wavelength domain offset) will have to be re-computed. 

To re-use the interpolation coefficients: 

• Load the spectral profiles, enter the non-linear calibration mode. 

• Load the coefficient by clicking the "Load" button in the interpolation section. The coefficients 
are updated. 

• Enter "0" in the constant field box 

• Select one line in the spectral profile and fills the wavelength 
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• Click on Apply – the calibration is made and the cursor position on the profile references the 
wavelength. 

• To reset all coefficients, click on the "Reset" button 

The "Apply" button in the interpolation section recompute the calibration if one of the coefficient is 
changed, like the cosntant. If one on the wavelength table value is modified, the "Calcul" shall be 
hitted again to re-compute the interpolation law. 

Load an equation 
Load the set of coefficient of the equation which defines the relationship between the pixels and the 
wavelength by using the Load button. When loading a file, its name and path is kept int he yellow 
section. Next time you'll use this function, you can just click on the checkmark button on the side of 
the yellow field to reload the file in the list area. 

Save a list of wavelength 
List of wavelengths can be saved and then re-loaded if a set of lines are used regularly to calibrate 
the spectrum. As for the equation, use the button LOAD and SAVE on the side of the wavelength 
list frame. The file extension is .lst 

Load a list of wavelength 
Load a list by using the Load button. When loading a file, its name and path is kept int he yellow 
section. Next time you'll use this function, you can just click on the checkmark button on the side of 
the yellow field to reload the file in the list area. 

Inflexion point 
If the dispersion law has an inflexion point, Visual spec inhibits the calibration . A sound is emitted 
and the word "inflexion" is written in red under the graphical representation of the dispersion law. 
Inflexion point are an indication of something wrong in the process as for one pixel position only 
one wavelength shall correspond. 

 
 

To modify values in the wavelength table: 

• Click one time on the line to edit the wavelength 

• Click two times to edit the barycenter (pixel position) 

Note: 
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dλ dispersion law 
For a greater accuracyin the calibration,  more reference lines than the minimum required by th 
einteroplation degree can be added. For each line, the difference between the calculated value and 
the observed value  is displayed. 

The difference are listed in the d_lambda column. 

 
In order to take those differences into account in the final dispersion law: 

• Check the box  "delta lambda" in the "Lambda" frame 

 

• Click on the bouton "Calcul" to compute the dispersion law  

The dispersion computation apply  a linear interpolation between each difference and add it to the 
lambda computation. 

 

The lambda difference are not saved with the interpolation law coefficients. They shall be re-
computed at each time. 

Changing the appearance of a profile document 
Enlarging, reducing a window 

The Profile document has an adjustable size.  Adjustment of the size is done as for standard 
Microsoft windows.  To maximize the window, click on the “maximize” symbol of the window. 

Thumbnails 
To view a collection of profile documents, it is possible to reduce all the windows to a small 
thumbnail format. 

• Click on the “Windows” menu, choose “Small Windows". 

Note: 
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Adjusting Format 
One can automatically put the document window into the format of its original image. 

• Click on the “Windows” menu, select “Adjust”. 

Or 

• Click on the "Medium Size" button  of the Profile toolbar 

A pixel in the graphic area of the profile will correspond to a pixel of the original image if the series 
is viewed in its entirety, from first to last pixel. 

Pre-defined Format 
It is possible to define and apply a particular size, different from the Small or Adjusted size, to a 
profile document. 

 
To apply a pre-defined size: 

• Click on the "User Defined Size" button  in the Profile toolbar 

Or 

• Click on the “Windows” menu, select ““Predefined” 

The default size can be modified by using the “General” tab in the “Graphic” dialog box. 

• Click on the Format menu, select "Graphic…" 

Note: 
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• Select the “General” tab 

• Edit the X and Y size fields, in units of pixels 

• View the results by clicking on the “Preview” button 

• Click on the button “Cancel” to return to the original size 

• Click on the button “OK” to close the dialog box. 

Display graduated axes and a title 
To display the graduated axes of the active series of a profile: 

• Click on the Format menu, select "Graphic…" 

Or 

• Click on the buttons  in the toolbar 

The "Graphic…" dialog box is displayed 
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Tab Axis X 
• Click on the tab "Axis X” and check the checkbox “Display X Axis” to view the X axis 

graduations 

Or 

• Click on Auto checkbox. The application will define automatically the best combination of ticks 
and graduations 

• Check the checkbox to “Display title” so the title of the graph will be displayed in the 
predefined corner of the application. The title of the graph is entered in a textbox on the General 
tab 

Tab Axis Y 
• Click on the tab “Axis Y”   

Or 

• Click on Auto checkbox. The application will define automatically the best combination of ticks 
and graduations 

• check the checkbox “Display Y Axis” to view the Y axis graduations. 

• Check the checkbox "Display gridlines” to view the grid in horizontal dashes for each major 
graduation 

The axes display two types of graduations: 

Simple graduations or “ticks” are displayed by plain dashes.  The distance between two simple 
graduations is defined by the value of the tick.  If no value is entered into the textbox “tick” then this 
value will be automatically calculated. 
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0.2

0.1

Tick

Nb
Tick

 
Labeled graduations are defined by the number of simple graduations or “ticks” separating them, 
and are displayed using a longer dash and the X or Y value. 

If no value is present in the “Tick” text area, the application automatically determines the most 
suitable value. 

The graduations apply to a document and not to a series.  If one selects a different series, the 
graduation of the axes may give less desirable results.  Then adjust the graduations to display. 

On the Y axis, if the application detects a difference too large between the value automatically 
proposed by the application and that entered by the user, it will use the automatic value. 

• Click on “Apply” to view the result 

• Click “OK” to close the dialog box and save the result. 

 

 

Short-cut "graduations on" 
When clicking on the "display graph" button  on the profile document side toolbar the auto 
function is also activated 

The function to display the graduation will update the display everytime the window is resized. For 
better performances, switch off the graduation display when resizing the window.  
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Graph title 
Visual Spec offers the possibility to add a title and two lines of comment superimposed onto the 
image 

• Click on the “General” tab 

 

• Enter the graph title in the field “Graphic title” 

• To automatically display the date or comments from the header, click on the button “Entete” 
(“Header”). 

• Freely edit, as needed, the date and comments lines, which will be displayed underneath the 
title. 

• Check the checkbox “Display title” in the tab “Axis X”. 

 
Once the title is displayed, it is possible to move it within the image. 

• Place the cursor in the area of the title, and the cursor will become cross-shaped 

• Click and hold the left mouse button while moving the title to the desired place. 

 
After resizing, the title will always return to the upper right corner. 

 

Note: 
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Doppler shift scale 
To graduate the profile in Doppler shift (km/s) relative to a given wavelength on the X axis: 

• In the tab "Axis X", mark the Doppler box and enter the wavelength value in the lambda text 
field.  

 

• Click on Apply to check the result. Adjust the ticks and Ticks Nb if needed. 

 
 

The doppler shift values are computed versus a reference wavelegth Lamda following the equation 
formule ((Lambda – Lambda ref ) / Lambda ref) * c, c beeing the light speed in en km/s – 
300000km/s 

The document is not modified, only the display takes into account the new X values. To save the 
serie along with the Doppler shift export the current document in .dat format. (Doppler shift – 
intensity"). 

• Click on menu File, choose Export .dat 

A .dat file will e created with the same name but the .dat extension in the current directory. 

Note: 
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Changing the color and font 
To change the background color of the Profile document 

• Click on the Format menu, select “Background color…” 

The “Color” dialog box will be displayed. 

Click on the color to display as the background of the document 

Click on “OK” to close the dialog box and apply the selection 

As needed, also change the colors of the series by selecting from the color control of the Profile 
toolbar to apply a new color to the active series. 

The color is specific to the active document.  Redo the operation to change the background colors of 
the other Profile documents. 

To change the text font 

• Click on the Format menu, choose Font…” 

The “Font” dialog box will be displayed 

• Select the font and font style options 

• Click on “OK” to close the dialog box and apply the selection 

The text font applies to the axis graduations or line labels. 

 

 

Cursor synchronization 
Synchronize the move of the cursor on all the opened  profiles. 

Activate the mode with the button  

The cursor of all the open profiles will move at the wavelength of the cursor of the active profile. 

Note: 
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Export to other applications 
The Visual Spec application offers a certain number of links to standard applications by generating 
files compatible with the formats used by these applications.  These formats are: 

.fit format with BeSS keywords  

.bmp files, for saving the spectral profile 

.txt file, compatible with spreadsheets, for exporting values from .spc files to other applications for 
data processing. 

.dat file, text format that contains only the active series in the form of two columns. 

Exportation as fits "BeSS" 
To export a file in the fits format, Vspec offers you to format the fits file required parameters and 
update the Fits BeSS new keyword to make the fits file directly compatible with the BeSS database. 
This database is operated by the GEPI team, at Paris-Meudon observatory, and is dedicated to Be 
Stars. See the base at http://basebe.obspm.fr/basebe/Accueil.php 

To configure your BeSS paramaters, default settings can be updated in the preferences, tab "BeSS(1) 
" and "BeSS(2). 

Profile exportation 
To convert the active profile: 

• click on menu "file", sub-menu "Fit export" 

http://basebe.obspm.fr/basebe/Accueil.php�
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A dialog box is displayed 

Dialog box "BeSS – fits data" - description 

 
Visual Spec automatically extract paramaters from the spc file header. So, it is your interest to fill it 
and to update the default settings in the preferences 

• Object name: By default, Vspec takes the name of the file without its extension. The object 
name shall be recognized as one of the official name of the object. You can check it bu 
checking the "Simbad" database: http://simbad.u-strasbg.fr/sim-fid.pl 

http://simbad.u-strasbg.fr/sim-fid.pl�
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• To check the onbject name, you can make a "Simbad" search by clicking the "Simbad" button. 
Vspec will prompt for the name and launch internet for a Simbad request.  

• Observation date: date of the beginning of the observation, extract by default from the header. 

• Observation time: the time of the beginning of the observation, extract by default from the 
header spc. 

• Exposure duration: This shall be the total duration of the observation, extract by default from 
the spc header. From the BeSS specification, it is not only the cumulated time of the exposure, 
but the total length of the observation. Date and time of the last exposure + its exposure time 
minus the date and time of the beginning of the first exposure. 

• Observer: by default, extract from the preferences, tab Bess, Observer. 

• Instrument:  by default, extract from the preferences, tab Bess, Instrument – or can be chosen 
in the drop-down list above 

• Site :  by default, extract from the preferences, tab Bess, Observation site – or can be chosen in 
the drop-down list above 

• The BeSS database expect to receive spectra with minimum processings: wavelength calibrated 
and response corrected. But in some case, other processings could have been applied like 
atmospheric lines correction, then check the option box, or continuum corrected, then check the 
option box accordingly. 

To export the file in fits format, click on OK. The dialog box is closed and a new one appears to ask 
for the directory and the file name to be saved.  

Vspec is able to read fits file which are 1D spectral profile. (not echelle spectrum). But for the best 
performances of Vspec it is recommended to convert it into spc format for all the spectral functions. 
You'll have to export it again if you want to stay with the fits format. 

 

To ease the data typing and to avoid errors which will be found by the BeSS verifier, Vspec has 
some helps and warnings included: 

• If you move the cursor over the lables, a tip window is displayed with information on the 
parameter to enter, like format of meaning. 

 

• If the small square button is clicked, a tip window is displayed with the original entry of the spc 
header 

 

• In some text field, as long as the entry does not meet the expected format, the background is in 
light pink.  



Manuel de Référence Profile 
 
 
 

Visual  Spec Export to other applications | 71 
 

.bmp Image 
To create a .bmp image of the active Profile document: 

• Click on the "File” menu, select “Export bmp” 

or  

• Click on the side button  in the document side toolbar  

A dialog box to enter the file name will appear. 

 
By default, the .bmp file will take the name of the .spc document with the .bmp extension, and will 
be saved in the working directory. 

The saved image is a copy of the image area of the active document, graduations, cursor and color 
included. 

.txt Profile 
To create a .txt file from the active Profile document: 

• Click on the “File” menu, select “Export txt” 

The .txt file will take the name of the .spc document with the .txt extension, and will be saved in the 
working directory. 

The text file contains the set of values of each series of the .spc document, each line being formatted 
in the following manner: 

 
0  
768 number of pixels in the series 
value that is not used  
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22/04/1998 00:09:45.84 date and time of start of pose (exposure?) 
22/04/1998 00:09:51.84 date and time of end of  pose 
6 times de pose in seconds 
SpectroCB Véga comments 
0 value not used 
0 value not used 
0 value not used 
0 value not used 
0 value not used 
.spc extension of original file 

pixel tab angström tab intensité tab Ref1 tab Ref2 tab normalise tab repère cr series name 
1 tab 5925.349 tab 29612.8163 tab 10733710 tab 0 tab 0 tab 0 cr values by pixel 
2 tab 5927.968 tab 32720.3065 tab 10733710 tab 0 tab 0 tab 0 cr 
... 
 
The tab characters tab and line-returns cr are placed to facilitate reading of the .txt file by a spreadsheet 
application such as Excel.  Each cell will contain one value for the set of lines. 

.dat File 
to create a .dat file from the active Profile document: 

• click on the “File” menu, select “Export dat” 

The .dat file will take the name of the .spc document with the extension .dat, and will be saved in the 
working directory. 

The format of the .dat file is ASCII, comprised of two columns.  The first column contains the 
wavelength, the second column contains the spectral intensity of the active series. 

.gif or .png file 
See the "GnuPlot" section later in this manual. 

Points list 
It is possible to point and store a liste of wavelength and intensities up to 7 or 9 points cliked ina 
profile. 

• Click in the menu Tools, sub-menu 7pts 

A new window is displayed 

 
Move the cursor over the profile on the values (point) you want to memorize. Click on it. 
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A small rectangle is diaplyed around the point selected. When the cursor is moved over this 
rectangle, the wavelength is displayed on the top-right. 

To cancel a point, click on the rectangle you want to remove, then press "Suppr" or "Del" to remove 
it.  

The window displays the number of points to reach the upper limit of 7 or 9 points. You can change 
the uppert llimit with the radio button. 

To finish and export the list in the file liste7pts.txt, click on the big button on the right. 

 

Clipboard 
To rapidly copy the image window of a profile document, one can use the Clipboard. 

• Click on the Edit menu, select Copy 

• Select an application that supports the image-copying function of the Clipboard 

• Paste the contents of the Clipboard; a .bmp image of the active profile document is pasted. 

 
To display an image frame, display the graduated axes. 
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C H A P T E R  5  

Spectral Series 

 
 

The creation of a spectral series is at the base of the set of functionalities of Visual Specs. 

A spectral series is a curve representing spectral intensity as a function of wavelength. 

One can modify their format:  scale in X and Y, zoom to an exact area, clear the display of a series, 
display the wavelength of a selected line.  These operations only modify the way in which the series 
is viewed. 

It is also possible to add series by copy/paste, to suppress a temporary series, or to replace one of the 
basic series with one of the temporary series. 

One can modify a series by applying transformation operations such as translation or by applying 
simple arithmetic operations with a constant.  One can combine several series to achieve a re-
sampling or a composite. 

One can create temporary series as a result of an operation applied to the selected series, such as 
filtering, normalization, derivation, calculation of a Planck profile, and some operations such as 
division that combine the active series with another series.  It is possible to save a temporary series 
by replacing one of the four basic series with the temporary series to be saved. 

One can modify, pixel by pixel, the intensities of a series. 

A toolbox dedicated to measurement of an area of the spectrum, such as a line or a continuum, 
contains the basic calculations of spectrometry or statistics:  full width at half-maximum, signal-to-
noise ratio, center of a line, equivalent width, average, standard deviation.

Format 
It is possible to modify the scale of the series displayed in the profile document using the vertical 
toolbar of the document. 
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Or, by using the "Graphic…" dialog box. 

• Click on the Format menu, choose "Graphic…" 

Or 

• Double-click in the graphic area  

 

Modify the scale 
This operation concerns, needless to say, the active series. 

The scales of the series are: 

In X: min and max value of the domain in wavelength, or min and max pixel number 

In Y: min and max value of the intensity of the profile 

The Y axis of a series is scaled automatically when it is displayed, starting from the maximum 
intensity of the profile multiplied by 1.1 (the min value being fixed at 0). 

The X scale of a series is scaled automatically when it is displayed, based on the min and max 
wavelengths or pixel numbers of the profile. 

If the min and max values of these scales are modified, the new values are used. 

Modification of the min and max values of these scales is done using the “Graphic…" dialog box. 

• Click on the Format menu, choose “Graphic…", and click on the tab “Axis X” or “Axis Y”  

Or 

• Click on the buttons “Scale X"  or “Scale Y”  in the profile toolbar. 
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X Axis Scale 

 

• Click on the tab “Axis X”  

• Enter the new thresholds "X min" and "X max" for the X scale of the profile into the editable 
fields 

Or 

• Click on the Right/Left control arrows to increase/decrease the value by ten percent. 

• Click on the checkbox “Angstrom units” to edit the thresholds in Angstroms.  By default, the 
min and max values represent the pixel number in the profile or the coordinates of the min and 
max pixel. 

• Click on the checkbox “Apply to all windows" to make the change in scale apply to all 
displayed profile documents. 

• Click on the button “Apply" to instruct the application to apply the scaling. 

• Click on the button “Reset” to return to default values 

• Click on “OK” or in the close symbol of the dialog box to make it disappear. 

When the min and max values of the X scale are lower, higher than the real min and max values of 
the profile, cursor movement is limited to the effective area of the spectral profile. 

 

Note: 
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Y Axis Scale 

 
Enter the new high and low thresholds Y scale of the profile into the editable fields 

Or 

• Click on the Right/Left control arrows to increase/decrease the value by ten percent. 

• Click on the checkbox “Apply to all windows" to make the change in scale apply to all 
displayed profile documents. 

• Click on the checkbox “Apply to all series" to make the change in scale apply to all the series 

• Click on the button “Apply" to instruct the application to apply the scaling. 

• Click on the button “Reset” to return to default values 

• Click on “OK” or in the close symbol of the dialog box to make it disappear. 

Vertical toolbar of the profile document 
It is also possible to make adjustments to the Y scale very quickly using the vertical toolbar of each 
Profile document. 

Decrease the max threshold of the active series by 10% 

 Increase the max threshold of the active series by 10% 

 Apply the changes to all series 'Lock" 

 Apply the max threshold of the active series to all the series 

Find the max of all the series displayed and apply it to all all series 

 Display the graduated axes 

Erase all overlayed graphics like label lines 

Unzoom 
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It can happen that the changes or equalization of thresholds does not permit viewing certain series in 
the document.  To return to the original display, select the invisible series in the control listbox of 
the Profile toolbar, then display the "Graphic…" dialog box and click on Cancel. 

Zoom 
A more direct method for changing the X scale is available using the zoom function. 

• Select a spectral area 

• Click on the button “Zoom”  of  the Profile toolbar 

The X scale will be automatically adjusted to the lower and upper borders of the selected spectral 
area. 

To cancel the zoom, click on the "Cancel zoom" button  of the Profile toolbar. 

To immediatly make a zoom on a profile region, maintain the "Maj" key while clicking and 
dragging on the region. 

Horizontal sliding bar 
If the profile displayed is longer than the section the section displayed, you can slide along the 
profile whilae maintainaing the same zoom factor. Move the cursor toward the bottom of the graphic 
zone to make the horizontal sliding bar appear. 

 

Interactif zoom 
This function of zooming and translating the spectrum ease the visual correlation between to spectra 
or to simply explore a large spectrum. 

• Click on the menu Format, choose Zoom… 

or 

• Use the shortcut Ctrl+Z 

A dialog box appears 

 
Move the zoom slider to modify real time the zoom factor of the current profile document. 

Note: 
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The same way, move the Axe X slider to translate the display of the spectrum; 

The Xmin and Xmax values represents the start and end values (either wavelength if calibrated or 
pixel number is not). Above the spectral extent is displayed . 

Applying the same format 
This function is an alternative to the option “Apply to all windows" of the Axis X dialog box with in 
addition the setting of all the windows size to the active window size 

To apply the X scale and the window size of the active window to all the windows: 

• Select the window from which one would like to extend the format to the other windows 

• Click on the Edit menu, choose "Apply format" 

Or 

• Click on the "Paste format" button  of the Profile toolbar 

Clear a series 
Clearing a series makes it disappear from the display, but does not remove it from the listbox of 
series. 

To clear a series: 

• Select the series to clear 

• Click on the Edit menu, choose Clear 

Or 

• Enter Ctrl+D at the keyboard 

Label the wavelength of a line 
Labeling a line consists of displaying, under the barycenter of the line, a label indicating the 
wavelength of that line. 

• Select the line to label 

• Click on the menu Tools, choose Label 

Or 

• Right-Click in the selected area.  The pop-up menu will be displayed.  Select the item Label 
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The line label will disappear each time the window is refreshed.  Refreshing a window happens 
when one changes its size, displays a new series, or activates a new window. 

 

Automatic selection of a spectral line 
To select a line in a profile, the standard method is to click-drag the mouse around the line. 
Whatever the profile is, the selection will be what is inside the gray rectangle. 

It the spectral line are about the same (a constant driven by the spectrograph design), a short-cut is 
available: 

• Click on the line while maintaining the Ctrl key  

Visual spec will first detect the max (or the min if absorption lines) around the cursor position with a 
range specified in the Auto Sel Line specified in the preferences. 

Note: 
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Onse the max (or min) is found, the slection start and stop are defined by the Auto Sel Line width.  

Crop a serie 
The crop function allows for keeping only a section of the profile  

• Select the spectral zone to keep 

• Click on the menu Edition, Choose Crop 

or  

• Click on the button  in the profile toolbar 

 

Caution: this operation is not reversible. It definitively invalidates non-included pixels after saving. 

Adding, replacing, and deleting 
Copy a series 

To copy a series: 

• Select the series to copy 

• Click on the Edit menu, choose Copy 

Or 

• Click on the Copy button  of the Profile toolbar 

Note: 
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Or 

• Enter Ctrl+C on the keyboard 

The copy operation can also copy a bitmap of the document to the Clipboard.  Open an application 
that will accept a bitmap image and paste into it the contents of the Clipboard. 

Paste a series: 
To paste a series: 

• Select the document to which the series will be added 

• Click on the menu Edit, choose Paste 

Or 

• Click on the button Paste  of the Profile toolbar 

Or 

• Enter Ctrl+V on the keyboard 

The series will be added to the list of series in the Profile document and become the active series.  It 
will have a generic name “SerieX” where X is an incremented number. 

If both the series to be pasted and the Profile document to receive the series are calibrated in 
wavelength, it will be resampled using the wavelength calibration of the “intensity” series of the 
destination document. 

If the destination Profile document is not calibrated in wavelength or if the series to be pasted is not 
calibrated, and if the serie to be pasted has the same number of pixels as the destination document, 
then it will be displayed without scaling as a function of the number of pixels.  If the number of 
pixels is different, the operation is not possible and a warning message will announce that the series 
are not compatible.   

When no series is copied, the Paste button is inactive. 

In the bottom status bar, the origin of the serie and the date of  its file will be displayed. This helps 
to know where the paste serie comes from. 

Replace a series 
To replace a basic series with the active series: 

• Click on the Edit menu, choose Replace 

Or 

• Click on the Replace button  of the Profile toolbar 

The “Replace…" dialog box is displayed. 

Only the active series of a document can replace a basic series within the same document. 

The series is resampled using the calibration of the “Intensity” series. 

 

Note: 
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To replace a series by a series from a different document, use Copy/Paste between the two 
documents. 

“Replace…" dialog box 
• First select the active series that will replace one of the basic series.  (See section “Selecting a 

Series”.) 

 

• Click on the radio button corresponding to the basic series whose values are to contain the 
values from the active series 

• Click on the “OK” button to close the dialog box and replace the series 

• Click on the “Cancel” button to cancel the operation 

Delete a series 
During execution, certain temporary series are generated and added to the list of series of a 
document.  To delete a temporary series 

• Select the series to delete 

• Click on the Edit menu, choose Delete 

Or 

• Press the DEL key on the keyboard

Modifying a series 
Arithmetic operations 

To apply a simple calculation using a constant: 

• Click on the Operations menu, choose "Arithmetic Operation" 

A dialog box is displayed 

Note: 
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• Select the arithmetic operation to perform 

• Enter the parameter 

• Click on the button Apply to view the result 

• Click on the button Cancel to cancel the operation 

• Click on the button Close to close the dialog box. 

Low-pass Filtering 
Low-pass filtering consists of replacing the value of the pixel by the average of the n pixels 
surrounding it.  To apply a low-pass filter to a series: 

• Select the series to filter 

• Click on the Operations menu, choose Low-Pass Filter 

Or 

• Click on the “Filter” button  in the Profile toolbar 

Or 

• Enter Ctrl+F at the keyboard 

A dialog box for selecting the order of the filter is displayed.  The cursor is positioned automatically 
on the OK button. 

 

• Change the order of the filter by clicking on the Up/Down control arrows.  The value will 
always be odd.  The value area is not manually editable. 

• Click on Cancel to cancel. 

• Click on OK to apply the filter and close the dialog box. 

The new series that was created by filtering the active series will be added as a temporary series to 
the list of series of the document. 
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Its name is composed of the initial name of the active series to which a prefix Fb+<filter order > is 
prepended.  This operation can be repeated several times; each time a temporary series is added and 
becomes the active series. 

Example: 

Fb3.intensity 
Fb3.fb5.Ref1 

High-pass Filtering 
To better highlight the area where lines are present, it is possible to eliminate slow modulation from 
the spectral profile by dividing the spectrum by its spectrum filtered by a low-pass filter.  The 
function OptiDiv applies this type of automatic filtering. 

• Click on the Spectrometry menu, choose OptiDiv 

The application will automatically apply a low-pass filter of order 3 to the active series, and then 
divide the original series by the filtered series.  The result is a new temporary series of the name 
Division which is added to the list of series.  The series fb3.<series name> is also added to the list. 

 

 
 

Spline Filtering 
Spline Filtering interpolation is a powerful filtering which initially calculates the Spline coefficients 
and then rebuilds the profile starting from these coefficients with a softening factor. 

• Click on the Operations menu, choose "Spline Filter" 

The rebuilt profile is displayed in violet, superimposed.  A control for adjusting the softening 
parameter is displayed. 
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• Drag the slider with the mouse to modify the softening coefficient.  The value of the coefficient 
is displayed in the control’s header area.  The affect on the series is visible in real-time in the 
document window. 

• You can edit the adjustment bounds of the coefficient by entering the new values in the editable 
textboxes above and below the slider. 

• If you click on “Enter” while the cursor is in one of the editable areas, the slider and the 
softening parameter itself will be automatically adjusted to the new value. 

• Click on the Page Up and Page Down keys to move from one tabulated value to the next. 

• If the max value of 30000 is not strong enougth to correctly smooth th eprofile, click in the x10 
box to multiply by 10 all the slider values 

• Click on the Up and Down keys to move from one tabulated value towards the next by 
increments. 

• Click on the close symbol of the control to save the adjustment. 

The new filtered series based on the active series will be added as a temporary series to the series list 
of the document. 
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Its name is made of the initial name of the active series preceded by the prefix Sp. 

Example: 

Sp.intensity 

Gaussian filter 
The gaussian filter is another type of filtering which atenuates the noise of the spectrum by 
smoothing with a gaussian. 

To apply the filter 

• Select the series to filter 

• Click on the Operations menu, choose Gaussian Filter 

A dialog box for selecting the power of the filter is displayed 

Dialog box Gaussian filter 

 

• Enter the sigma value as a non-decimal value defining the strength of the filtering.  

• Click on Apply – Appliquer to apply the filter 

The new series that was created by filtering the active series will be added as a temporary series to 
the list of series of the document under the name serie.<g> 

 

• Click on OK to apply the filter and close the dialog box. 

Mmse filter 
The mmse filter is another type of filtering which atenuates the noise of the spectrum 

To apply the filter 

• Select the series to filter 

• Click on the Operations menu, choose Gaussian Filter 
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A dialog box for selecting the power of the filter is displayed 

Dialog box mmse filter 

 

• Enter the sigma value as a non-decimal value defining the strength of the filtering.  

• Click on Apply – Appliquer to apply the filter 

The new series that was created by filtering the active series will be added as a temporary series to 
the list of series of the document under the name serie.<m> 

 

• Click on OK to apply the filter and close the dialog box. 

If the coeeficient is not strong enougth the orange serie covers entirely the original serie 

 

Resample a serie 
Resampling a series with respect to another allows the two series to share the same calibration in 
wavelength.  This operation consists of resampling the active series by Spline interpolation based on 
calibration of another series. 

To readjust a series with respect to another: 

• Select the series to re-sample 

• Click on the Operations menu, select Recalibrate profil by a profil… 

A dialog box for selecting the series to be used for recalibration is displayed. 

 

Note: 
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Each Profile document open in the current session is listed in the left area.  The available series are 
displayed here.  Only the series that are calibrated in wavelength are listed.  The selected series is 
viewed in the graphic area and information on its spectral extent and sampling are displayed in the 
“Infos” area 

• To select a document, click on the document icon.  The list of series will appear 

• To select a series, click on the series icon.  Its profile will be displayed in the graphic area and 
the "Infos" will be updated. 

• To perform the recalibration with respect to the spectral calibration of the selected series, click 
on OK. 

• To cancel the operation, click on Cancel. 

 
Once started, the operation cannot be cancelled.  To return to the original profile, reload the 
document.  The option "Normalize and replace" is inactive. 

Binning 1:1 horizontal 
When a spectrum has a poor signal to noise ratio, this operation increase the signal at the expense of 
the resolution. It combines the values of two adjacent pixels into one by addition.  

Operations on two series 

Divide two series 
To divide one series by another: 

• Select the series to divide 

• Click on the Operations menu, choose "Divide profile by a profile…" 

Or 

• Enter Ctrl+D on the keyboard 

Note: 
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A dialog box will appear to select the series by…” (See section “Selection Dialog Box”.) 

The new series, corresponding to the result of the point-to-point division of the active series by the 
series selected in the dialogue box, is added as a temporary series to the list of the series of the 
document under the name "Division", and becomes the active series. 

Multiply two series 
To multiply one series by another: 

• Select the series to multiply 

• Click on the Operations menu, choose "Multiply profile by a profile…" 

Or 

• Enter Ctrl+D on the keyboard 

A dialog box will appear to select the series by…” (See section “Selection Dialog Box”.) 

The new series, corresponding to the result of the point-to-point multiplication of the active series by 
the series selected in the dialogue box, is added as a temporary series to the list of the series of the 
document under the name "Multiplication", and becomes the active series. 

Add two series 
To add one series to another: 

• Select the series to add 

• Click on the Operations menu, select "Add profile by a profile …" 

Or 

• Enter Ctrl+D on the keyboard 

A dialog box will appear to select the series by…” (See section “Selection Dialog Box”.) 

The new series, corresponding to the result of the point-to-point addition of the active series to the 
series selected in the dialogue box, is added as a temporary series to the list of the series of the 
document under the name "Addition", and becomes the active series. 

Subtract two series 
To subtract one series from another: 

• Select the series to subtract 

• Click on the Operations menu, choose "Subtract profile by a profile …" 

Or 

• Enter Ctrl+D on the keyboard 

A dialog box will appear to select the series by…” (See section “Selection Dialog Box”.) 

The new series corresponding to the result of the point-to-point subtraction of the active series from 
the series selected in the dialogue box is added as a temporary series to the list of the series of the 
document under the name "Subtraction", and becomes the active series. 
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Translate a series 
This operation shifts the absolute value of pixels or angströms of all the data points in the series. 

• Click on the Operations menu, choose "Translate…" 

The dialog box for adjusting the translation will be displayed 

 

 

• Enter the amount of the shift into the text area 

- If the profile is calibrated in wavelength, the shift will be displayed in angstroms 

- If the profile is not calibrated in wavelength, the shift will be displayed in pixels 

• Click on the "Apply" button to display the result 

Or 

• Click on the Up/Down control arrows to increase or decrease the translation.  The absolute shift 
is then immediately applied. 

• Click on the "Cancel" button to cancel the operation, close the dialog box, and return to the 
values of the series before the start of the operation. 

• Click on the "Close" button to save the translation and close the dialog box. 

 
To enter a decimal value less than 1, enter 0.2 and not .2. 

 

Normalize a series 
Normalization of a profile allows one to obtain the relative intensity of the profile with respect to a 
reference continuum of 1.  This continuum is calculated based on the average of the area of the 
profile whose boundaries in angstroms are defined : 

- If no profil selection is in progress; by the values defined in the “Preferences…” dialog box, 
“Continuum” tab.  (See section “Preferences” in chapter “Introduction”.) 

- if a profil zone is selected (gray visible rectangle), by the limit of the selection. 

To normalize a series: 

• Select the series to normalize 

• Click on the Operations menu, choose Normalizeation 

Or 

Note: 
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• Click on the button “Normalise”  in the Profile toolbar. 

The intensity serie is automatically replaced by the normalized values. 

This step of normalization is needed to calculate the equivalent width of a line or to compare two 
spectra of the same object taken at different times without requiring a spectro-photometric 
calibration.  (See section “Comparison of Profiles”.) 

The information window is displayed with the exact boundaries of the spectral zone where the 
average signal has been computed. 

If you do not want to discard the original intensities values, save the file under a new name. 

You override the preset continuum values from the preferences by selecting a profile zone with the 
mouse on which you want the average computation being performed. 

Derive a series 
To derive the active series 

• Select the series to derive 

• Click on the Operations menu, choose “Derive” 

The new series corresponding to the result of derivation performed on the active series is added as a 
temporary series to the list of series of the document with the name “derivee.<active series>”, and it 
becomes the active series. 

If the series does not appear in the window, verify that the scale in X is correct. 

 

Stack several series 
Stacking permits addition of several series of the same object in order to increase the final signal-to-
noise ratio.  The operation is performed starting from the “Intensite” series of each document. 

If the spectral sampling is different, rescale the spectra before adding. 

To stack a set of spectral profiles: 

• Open the set of documents to stack 

• Ensure that each has been calibrated in wavelength 

• Click on the Operations menu, select Compose 

Each “intensity” series of the displayed documents will be rescaled in wavelength with respect to the 
“intensity” series of the active profile and added to it. 

The active document then contains in its “intensity” series the result of stacking the set of profiles. 

• Save the new profile under a different name 

You can then verify that the signal-to-noise ratio has been improved with respect to that of similar 
non-stacked profiles. 

Note: 

Note: 
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Join two series 
Joining two series creates a new Profile document whose “intensity” series contains the two joined 
series, normalized over the area of overlap.  This operation is only possible if one of the series was 
calibrated in wavelength. 

To join two series 

• Select the first series 

• Click on the Operations menu, select Join 

A dialog box for selecting the series “by…” allows the choice of the second series.  (See section 
“Selection dialog box”.) 

A new Profile document is created under the name “newspc”.  The “intensity” series contains the 
results of the operation. 

The reconciling of the two series is done in the following manner: 

• The overlapping area of the two series is detected 

- If there is no overlapping area, the operation is cancelled.  The message “no area of overlap” 
is displayed. 

- If one series is completely included within the other, the operation is cancelled.  The message 
“series a includes series b” is displayed. 

- If the two series overlap strictly, the operation is cancelled.  The message “the two series are 
super-imposable” is displayed. 

• The normalization of the two series is carried out starting at the area of overlap.  Each series is 
normalized at the start of the area to be joined. 

• The first points of the new series will contain the first points of one series until the start of the 
area of overlap is reached.  The subsequent points will be those of the other series. 

To save the result, save the new Profile document with the command “Save” or “Save As…”. 

Modify the intensity of a pixel 
Aberrant points may interfere with correct execution of the automatic processing of Visual Spec.  
For this reason, it is possible to individually modify the intensity of each pixel. 

To modify the intensity of a pixel: 

• Click on the menu Edit, choose Pixel 

A window appears.  It contains the complete table of pixels and their intensity. 
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To modify the value of an individual pixel: 

• Click twice on the pixel to modify, the intensity is highlighted and is then editable. 

• Modify the value. 

• Repeat as needed for other pixels. 

To more easily find a pixel whose order number one knows: 

• Enter the pixel number in the search area 

• Click on “Select” 

To terminate the operation 

• Click on OK to save the modifications.  The series will be updated automatically. 

• Click on Cancel to cancel all modification. 

Measurements 
A certain number of simple measurements are possible on a spectrum calibrated in wavelength.  
These measurements can be used to characterize the quality of the spectrum or to identify and/or 
measure the spectral lines. 

The measurements are made on the spectral profile area selected with the cursor. 

To select the type of measurements to execute: 

• Click on the menu Spectrometry, choose  Computation preferences 

The dialog box that allows the selection of measurements to perform will be displayed. 
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• Check each checkbox corresponding to the measurement whose result is desired. 

• Click on the button Cancel to cancel. 

• Click on OK to save the list of measurements and make the dialog box disappear. 

To change the list, redisplay the dialog box by clicking on the menu Spectrometry, choose  
Computation 

To execute the list of calculations and view the results: 

• Click on the Statistics button   on the Profile toolbar 

The list of measurements to perform is reused each time the operator requests measurements on a 

profile zone using the Statistics button  

The results are displayed in the “Infos…” window, which appears if it was not already displayed. 

By default, no measurement is active in the list; if one requests measurements then the dialog box of 
calculations will be automatically displayed. 

 

Infos… Window 

 
The Info window permits viewing and tracing the results of measurements made on a spectral 
profile.  It is possible to modify the size of the window with the mouse.   

The name of the document on which measurements were taken is noted in red.  Then the result of 
each measurement is displayed. 

• Click on the “Reset” button to clear all displayed results. 

Note: 
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• Click on the “Header” button to display the ‘date’, ‘pose’ (exposure), and ‘comments’ field of 
the active document. 

• Click on the button “Save” to save the results in the text file “Infos.txt”.  This file will be found 
in the application directory. 

• Click on the close symbol of the window to hide the window 

Or  

• Go in the tools menu and select the sub-menu "infos" to hide the window 

• Use the scrollbar to access preceding results, if they were not cleared. 

Signal to Noise Ratio  
Calculates the signal-to-noise ratio over the selected spectral area.  The signal-to-noise ratio is the 
report of the standard deviation of the average. 

Average  
Calculates the average over the spectral area. 

Std deviation  
Calculates the standard deviation of the average over the spectral area. 

Line center  
Calculates the wavelength that corresponds to the barycenter of the selected area.  This wavelength 
defines the wavelength of a spectral line. 

FWMH 
Calculates the full width at half-maximum over the spectral area. 

The half-maximum of a line is defined as (the maximal intensity of a line with respect to a reference 
taken on the points on each side of the line) divided by two. 

The full width at half-maximum of a line is defined as the deviation in wavelength (or in pixel if the 
series is not calibrated) between the two borders of the lines at mid-height. 

This measurement is only possible on an area with a minimum of three points.  The reference of the 
continuum is the average between the first and last point in the selection. 

This calculation is fragile if the first and last points are those of the line itself, if the selection is too 
tight, or if other lines are present at the borders of the line to measure. 

Barycenter 
Calculates the barycenter in pixels of the spectral area 

The barycenter is defined as the sum of the points multiplied by their index divided by the area of 
the zone. 

Note: 
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The area of the zone is delimited by the spectral profile and a straight line joining the first to the last 
point. 

Intensity 
The line intensity is the line surface.  

Equivalent width (LEQ) 
To calculate the equivalent width of a line, it is necessary to normalize the profile.  Otherwise the 
results make no physical sense. 

The Width Equivalent is a computation of the line surface normalized to the background. 

The calculation takes place over the spectral area delimited with the cursor in the active series. 

An equivalent width of the line will be displayed in the “Infos…” window, expressed in angstroms.  
It characterizes the power (calculation of area) of a line with respect to the continuum. 

Surface 
Surface computation of the profil included in the selection. The surface computation is a simple sum 
of the intensity of the pixel. 

Resampling 
To resample the profil, you need to define the new sampling step and the starting limit 

• Click on the menu Spectrometry, select "Resampling" 

A dialog box "sampling" is displayed 

 
The current value of the beginning and end of the profil are displayed in gray 

• Enter the new value of the sampling step 

• Modify or not the start and end limits 

• Click on OK to execute 

• Click on Cancel to quit without executing or exit 
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The intensity serie is replaced by the new resampled serie. If you want to keep the result, save the 
file under the same name or change the name by doing a "Save As…". 

 

Fit Photosphere 
In some rare occasion, it can be of interest to suppress the contribution of the photosphere in a line 
profile.  

• Click on the menu Spectrometry, choose "Fit Photospher" 

A dialog box "Fit Phosotospher" appears 

 
By adjusting the different sliders, it is possible to generate a gaussian profil centered to the Lamb 
Ref field value which is subtracted to the current serie. 

 
The purple profile is the gaussian profile and the serie Fphot.intensity is added to the serielist. 
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The green profile is the result of the correction and is added in the serie list as Soustnorm serie. 

To exit the function, click on the close box in the dialog box. 

This function shall be applied on a significant line profile.  

 

There is no modification of the current serie. To suppress the addded serie, just select it and press 
the delete button 

Heliocentric Speed 
To produce accurate measurements of Doppler Shit, the Doppler Shift of the Earth around the Sun in 
the direction of the object has to be taken. 

Visual Spec computesthis shift by taking into account the observation site coordinates, the date and 
time of the observation and the celestial coordinates of the star, alpha and delta. 

• Click on the menu Spectrometry, choose " Helio Correction" 

A dialog box appears 

 

 

• Enter the latitude and longitude coordinates of the observation site in decimal degrees.  

• In case of a fits file, if the Lat and Long data are present in the Fits header, they will be 
automatically displayed. 

• If not, or in case of an spc file, the coordinates preset in the preferences dialog box will be 
automatically loaded. 

Note: 

Note: 
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• Enter the Right ascension and the declinaison of the star – if the coordinates have been entered 
in the header of the spc document, those values will be displayed automatically. 

• Enter the date and time of the observation in day, month year. The day is a decimale value wich 
will take inton acount the time of the observation. 

• The computation requires the longitude convention being positive toward Est and negative 
toward west. It is the opposite of the convention of some planetarium software or Iris, but in 
accordance with BeSS convention. 

Example: 
 
Date = 9 Sept 2001 
Time (Heure) = 3h 32 mn 5s 
 
Month (Mois)= 9 
Year (Année)=2001 
 Day (Jour) non-decimal part = 9 
 Day (Jour) decimal part = (3 + 32/60 + 5/3600 )/ 24 = 0.147 
Day (Jour) = 9.147 
 
• Enter the reference value of the wavelength to compute the doppler shift which shall be applied 

to offset the Earth moving. 

• Click on "Calcul" to display the results in the Infos… window 

Or 

• Click on "close" to temporary hide the dialog box without loosing the data entered: alpha, delta, 
and date/time. 

or 

• Click in the close box of te dialog box to definitively close it and allow at next loading an 
automatic update of the alphe, delta, date/time of the current spc document. 

• The results are displayed in the Infos… window, which can be then saved. See the Infos… 
Window section. 

 

• Julian Day - Jour Julien:  date and time transformed in Julian Day– for info 

• Corr. Lambda (Angstrom):  Angström shift due to the Earth moving doppler shift. 

• Speed - Vitesse:  Speed motion in the direction of the object, to be corrected 

• Corr. JJ:  Time correction equivalence – for info 

• Azimuth:  azimuth of the object during the observation – for info 
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• Heigth - Hauteur: heigth of the object during the observation – for info 

• Air section - Masse d'air: Air section crossed by the light of the star during the 
observation – useful to correct from the atmospheric extinction.. See Extinction section in 
Radiometry. 

Heliocentric speed correction 
To correct the speed due to the earth computed with the heliocentric speed function above, click on 
the menu Spectrometry, sub-item Heliocentric speed correction. 

A dialog box is displayed 

 
Enter the speed value read from the infos window, then click apply 
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C H A P T E R  6  

Radiometry 

 
 

Radiometry concerns processing that corrects the intensity of the spectral profile. 

The raw intensity of a spectral profile is not only a function of the physical characteristics of the 
object observed.  It includes also local attenuation caused by the equipment used, spectral sensitivity 
of the capture device, and even attenuation caused by the atmosphere.  To compare spectra from 
different equipment, to reconstruct the physical continuum of the object, it is often necessary to first 
carry out a radiometric correction.  This correction is the equivalent of a Flat Field in direct imagery. 

To correct a raw spectrum it is necessary to determine the instrument response curve.  This 
instrument response can be obtained in several ways: 

• From the spectrum of one of the 24 stars calibrated photometrically within Visual Spec 

• From a standard spectrum of the sample spectral type, from the library 

• Once the spectrum has been corrected radiometrically, one can eliminate its physical continuum 
by synthesizing the Planck profile at the temperature of the object.

Spectral library 
Visual Spec provides a database of 131 spectra corresponding to different spectral types.  This 
database comes from the Centre de Données Stellaire of Strasbourg.  The 131 spectra are in the 
folder libspec.  The files are in “.dat” text format and extend from 1200 to 10600 angstroms.  The 
intensity is normalized from 1 to approximately 5550 angstroms. 

To access the library: 

• Click on the Tools menu, choose “Library…” 

The “Spectral library” dialog box will be displayed. 
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Dialog box Library 

 

• Select a spectrum by its spectral type.  It will be displayed in the graphic area at the bottom. 

• Drag the name of the spectrum to the active profile document to add the profile to the list of 
series. 

Or 

• Click on the green bouton arrow on the right side 

• To enlarge part of the spectrum in the graphic area, right-click near the part of the spectrum to 
be enlarged. 

• To quickly scroll through the spectral types, use the “Spectral type” slider. 

• To end the operation, click on the close symbol of the dialog box. 

The spectrum is added in the form of a temporary series whose name is that of the spectrum in the 
dialog box.  These series keeps its original sampling which is 5 angstroms.  To resample the 
spectrum to the sampling of the document, perform a resample (see section “Resampling”). 

It is impossible to add a spectrum from the library to a document which is not calibrated. 

Spectral type 
This function is only available if the Excel application is installed. 

To determine the spectral type of a star: 

• Click on the Tools menu, choose “Spectral type…” 

Note: 
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Or 

• Enter Ctrl+T using the keyboard 

A dialog box is displayed which asks for the name of the star to search for in the Bright Star 
Catalog. 

 
The syntax to be followed when entering the name of the star to search for is the following: 

• Three first letters of the Greek designation:  Gam, Alp, Omi, Ome … or star number followed 
(without a space) by the three-letter constellation abbreviation . 

The result of the search is displayed in the Type Spectral (Spectral Type) dialog box. 

 

The Bright Star Catalog is available in the form of an Excel file “brscat2.xls” in the application 
folder.  In addition to spectral type, it contains other information such as the coordinates, magnitude, 
HD reference. 

Continuum 
To more easily read the spectrum, it is sometimes useful to “flatten” its profile.  If one cannot 
suppress the “continuum” using a Planck profile, nor calculate the instrumental response from one 
of the reference stars in Visual Spec, it is still possible to calculate an artificial continuum by 
interpolation on some points of the raw profile. 

• Click on the Radiometry menu, “Extract Continuum…” 

• A new toolbar will replace the Profile toolbar. 

To leave continuum mode at any time: 

• Click on the Stop button  to leave Continuum mode 

Or 

• Click on the Radiometry menu, choose “Extract Continuum…”.  The checkmark on the menu 
will disappear 

Note: 
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Two methods are provided to obtain the continuum.  To toggle between them, click on the 

point/curbe button . 

Continuum by area suppression 
The continuum toolbar will change to look like this: 

 

• Select the area of the spectrum containing lines to eliminate. 

• Click on the eliminate zone button  of the toolbar to eliminate the selected area. 

• Repeat the operation to eliminate additional areas. 

• Click on the annule button  to replace the areas that were eliminated. 

• Click on the execute button  to activate reconstruction of the profile. 

The temporary series “Fit.<active series>” is added to the list of series and is displayed in the 
window in orange color.  The eliminated areas are interpolated by a straight line.  The dialog box for 
adjusting softening is displayed.  Once the adjustment is made, click in the close symbol of the 
control.  (See section “Filtering by Spline”.)  The toolbar disappears and is replaced by the Profile 
toolbar. 

Continuum by points 
To access this mode, click on the point/curbe button  

The continuum toolbar will change to look like this: 

 

• Place the mouse on the profile and left-click on the profile to place an input point. 

• Continue this operation until all input points have been placed. 

• Click on the Cancel button  of the toolbar to eliminate all points and restart. 

• Click on the execute button  of the toolbar to activate the reconstruction of the profile. 

The temporary series “Fit.<active series>” is added to the list of series and is displayed in the 
window in cyan color.  The toolbar disappears and is replaced by the Profile toolbar. 

Interpolation between points is by Spline interpolation.  It automatically uses the first and last point 
of the series.  If these points are aberrant, it is possible to edit them manually using the function Edit 
Pixel, or by cutting them from the Profile. 

• It is possible to save the list of points by clicking on the “Enregistre liste” (“Save list”) button 

.  The coordinates of each point are saved into the file “liste.txt” in the root folder of the 
application.  The list is used by the “Extraire…” (“Extract…”) function. 

Note: 
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Extraction  
This continuum extraction is done based on the list of wavelengths.  Each of the wavelengths must 
correspond to a place in the spectrum where it is assumed that no line is present. 

• Click on the menu Radiometry, choose “Extract…” 

From this list, Visual Spec calculates an interpolation by spline and displays the new spectrum in the 
series extract_ followed by a sequence number. 

The list of points comes from: 

• A text file “liste.txt”, if it is present in the root folder of the application.  

You can easely build this list if you first click on the points you need in a manual continuum 
extraction in "point" mode. This list will be saved if you click on the save icon in the continuum 
toolbar. 

Or 

• One of the pre-defined lists if the file “liste.txt” is not found.  These lists contain the following 
wavelengths: 

3390, 3448, 3509, 3571, 3636, 4032, 4167, 4255, 4464, 4566, 4785, 5000, 5263, 5556, 5882, 6055, 
6370, 6800, 7100, 7530, 7850, 8080, 8400, 8805, 9700, 9950, 10250, 10400, 10800 

It is possible to manually edit the file “liste.txt” with a simple text editor, following the format of a 
wavelength in angstroms per line.  If one or more wavelengths are outside the domain of 
wavelengths, the value is ignored.  If all the values are ignored, the default list is used. 

Extract from zone 
The continuum will be computed on the active serie but excluding the zone specified in the 
listzone.txt file. These zone are supposed to contain spectal lines.  

The file will contain the last zone selection made in manual continuum extraction. Or you can edit 
the file. The format is each line contains the limit of a zone  

5860.037,5994.185 

Automatic continuum 
Robustness of automatic function shall always be questioned 

Visual Spec offers the capability to automatically detect the continuum. 

• Click on Radiometry menu, sub-item automatic continuum 

A purple serie is added as the result of the detection of the continuum. The detection alogorithm 
shows which points has been selected to fit the continuum using a spline function. 
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This function is very intensive in term of computation. If you performed it on profile which has a 
large number of points, it can take a long time… 

If you resize the document, the green crosses will disappear. 

 

Compensation of the continuum 

By dividing by the continuum 
In only one operation it is possible to remove the continuum of a spectral profile. 

• Click on the Radiometry menu, choose “Continuum division” 

The continuum toolbar is displayed 

• Perform the operations on the continuum (see the section “Continuum”). 

Once the artificial continuum is calculated, the intensity series is automatically divided by this 
continuum. 

The intensity series is automatically replaced by the result of the operation.  If you don’t want to 
overwrite this series, copy it into a different basic series or save the document under a different 
name. 

Note: 

Note: 
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By subtracting the continuum 
It is mandatory that the serie has been normalized 

• Click on the menu Radiométrie sub-menu Continuum Substraction… 

Same as above for the division. but the continuum is subtracted the intensity serie and a value of 1 is 
added to avoid negative values. 

 

Suppresion of atmospheric lines 
Two functions are proposed: 

• Synthesis of an atmospheric spectrum from a file containing the atmosphere lines which has 
been defined in the preferences. The file included in the Vspec package covers a wavelength 
range from 6408 to 6628 angströms. 

• Correction by using a real spectrum of the atmosphere extracted from a star observation during 
the night 

Synthethic atmospheric correction 
The goal of this function is to reduce or suppress completely the water atmospheric lines in the 
spectral extent 6400- 6600 angstroms 

• Click on the menu Radiométry, choose H20 

To proceed with the interactive adjustment a diaoog box is displayed 

Dialog box H2O 

 

• Start by moving the Sigma slider to make appear the base line of the H20 profile 

• Follow by moving the instensity slider to increase the intensity of the lines 

• Adjust agin the sigma slider to more or less filter the lines. The H20 lines shall meet the 
spectrum lines to be corrected 

Compare the two profiles, you shall be in position to match the two profiles. Repeat the process until 
satisfaction is reached. 
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• In some cases, a slight shift in wavelength can be visible. In this case, adjust the shift in the shift 
section of the dialog box. The shift is applied on the original spectrum, not on the H20 
spectrum. 

- Click on the up/down arow box to change value by 1 

- One can enter directly decimal value and press enter to validate and apply the shift 

• To fine tune the overall matching process, check the "display division result" – "Afficher 
resultat division" box. A green serie is added as the result of the division of the two spectra. The 
interactive process shall drive to the elimination of the H20 lines. 

 

• Click on cancel to cancel the operation and come back to the original document 

• Click on OK to keep the result and come back to the original document 
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The corrected serie is added under the form of a temporary serie with name Division in the serie list. 

From one use to the next one, the paramters "sigma" and "intensity" are kept in memory. If the 
intensity value has to be adjusted during the night, the "sigma" value is quite often the same for a 
given night and configuration 

Real spectrum atmospheric correction 
The goal of this function is to reduce or suppress the atmospheric lines created by the water from a 
real spectrum of the atmophere of the night of observation. This spectrum is extracted from a star 
which has not a lot of lines. 

Before running this correction, the atmospheric spectrum shall have been computed and displayed. 

To extract the atmospheric spectrum: 

Acquire a spectrum of a star which has not a lot of lines (type A, like altair, or Vega) and for whom 
you have an already corrected spectrum. See in the ELODIE database from the Haute-Provence 
Observatory at http://atlas.obs-hp.fr/elodie/ . 

Normalise, then divide the ral object profile by the ELODIE profile: the resultating profile is the 
atmospheric profile 

Move this profile into a serie wich will be saved, like the "intensity" serie, and save the document, 
like "profile_atm_x". Keep the document open 

Go back to the profile to be corrected 

• Click on the menu Radiométry, choose H2O correction real spectrum… 

A dialog box to select the real atmospheric spectrum is opened 

Note: 

http://atlas.obs-hp.fr/elodie/�
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Boîte de dialogue sélection de profil réel 

 

• select the document and the serie which contain the atmospheric spectrum 

• click OK la série qui contient le spectre réel de l'atmosphère 

 

The function will proceed with the interactive adjustment, a dialog box is displayed 

Dialog box H2O intensity adjustment 

 
The intensity level of the ral atmospheric spectrum can thus be adjusted. The result of the correction 
can be seen real time by checking the "display division result" box. wavelength shift can also be 
adjusted. 

Report to the previous section on the synthetic correction for a more detailed description of the all 
controls. 
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Once the parameters adjusted, the serie "division" in green, contain the corrected profile. To save it, 
replace one of the non-temporary serie (like the "intensity" serie) by the result with the "replace" 
fonction, and save the file. 

 
 

 

Instrumental response correction 
The intensities of the raw spectrum acquired are the combination of the real intensities of the star 
spectrum and the multiple absorption which have happened before it gets stored. The main source of 
spectral intensities "modification" is the sensor used in the acquisistion process. In Digital Camera, 
CCD camera or webcam, the sensors used does not have the same spectral response. Some have a 
very response in the blue region, some have very good detection in the red regions. To get back to 
the star intensities, this instrumental spectral response curve has to be determined.  

This process is in 2 steps: 

1. Get the instrumental response from a spectrum taken from a well-known star, a reference star 
or calibration star 

2. Use this instrumental reponse to correct all the profiles acquired during the night 

How to get the Instrumental response 
You need to obtain the spectrum of a "non-variable", bright star,  from a spectral type closest to the 
1-type as possible. The A-type spectrum exhibits a very limited number of spectral lines, which is 
recommended as we are looking at the continuum profile in this operation. A star such vega is very 
well appropriated. 

To correct the active series radiometrically by using a spectrum from the library: 

1. Obtain the spectral type of the reference star. For Vega it is A0V 

2. Add the standard spectrum from the library which corresponds to the spectral type of the object 
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3. Extract the continuum of the standard spectrum, either by Spline filtering or by using the 

continuum function, in violet. (This step is not mandatory, the lines will be eliminated during 
the step 6 also). 

 
 

4. Select the series “intensity”. 

5. Divide the “Intensity” series by the series “Fit.spectre_standard”.  One thereby obtains the 
instrumental response in the serie “Division”, in dark green. 



Manuel de Référence Radiometry 
 
 
 

Visual  Spec Instrumental response correction | 115 
 

 
6. To eliminate the spectral lines, perform a Spline filtering or apply the Continuum function on 

the series “Division”.  The new series “Fit.division” will be added, containing the instrumental 
response, in orange. 

7. The orange serie is the instrumental response.  

 
At this step, the orange serie is the instrumental response curve. To save it, move it into the 
"intensity" serie and save the document under a new name like "response". 

This profile will be the instrument reponse of the night.  

Correct the profiles with the instrumental response 
The second step is to perform the correction. Load a spectrum of the night. Keep the response profile 
document opened. 

 
1. Select the serie of the dicument you want to correct 
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2. Divide the series “intensity” by the instrumental response “intensity” from the document 
response.  The series “division” then contains the radiometrically-corrected spectrum, in dark 
green. 

 
3. To save the series, replace one of the basic series by the series “Division”. 

 

The intensities obtained are not the absolute intensities of the object.  For an absolute spectro-
photometric calibration, it is necessary to use a real spectrum of one of the 24 stars calibrated in 
Flux.  (See section “Flux Calibration”.) 

Planck Profile 
The absolute intensity profile of a spectrum follows a law which is a function of the temperature of 
the star (dark-body temperature, Planck’s Law).  Based on this law, and thus on a temperature, it is 
possible to calculate the theoretical profile of energy per unit of wavelength this star would have. 

To display the Planck profile of a star of temperature T: 

• Click on the Radiometry menu, choose “Planck…” 

Note: 
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A dialog box is displayed. 

 

• Enter the desired temperature, or increment/decrement the temperature by clicking on the 
Up/Down control arrows. 

• Click OK to display the theoretical profile; a temporary series “P_<temp>”, where <temp> is 
the temperature, is added to the list. 

 

• Click on Cancel to cancel the operation. 

To determine the Planck temperature of a body 
Correct the intensity of the profile in order to obtain the theoretical intensity. 

Superpose the Planck profile for different temperatures until the two profiles have the same slope.  
To do this one can adjust the respective scales of each of the series. 

Note which temperature gives the best match  with the continuum – this is the temperature of the 
body observed … 

One can then “flatten” the spectral profile by dividing by the Planck profile, which then suppresses 
the “continuum”. 
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To save the Planck series, replace one of the basic series with the series “P_<temp>”. 

 

Automatic Planck law 
This function will find the best temperature which fit the Planck law until it matches the profile 
continuum.  

• Click on the menu "radiometry" sub-menu "Auto Planck…" 

 
 

A dialog box is displayed 
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• Enter the limits max and min into which Vspec will iterate to find the best value which fit the 
continuum using the mean square method. 

• Enter the step of the iteration. A small step will drive a better accuracy but the oteration will 
take longer. It shall be noted that in any case the result shall be consider as an indication and not 
a real scientific exact value. This method is not accurate enough, but result is a good astrophysic 
indication and can be an interesting educative exercise. 

• Click ok to run the computation 

A black curve is displayed as the best  Planck profile fit as an additional serie. To know the 
temperature, go in the drop-down serie list and look at the name of the added serie. It will have the 
name P_ + the temperature of the best fit in Kelvin. 

 

 

Absolute flux instrumental reponse 
If you use the standard spectra from the Vspec library, the intensities of those spectra are not 
calibrated in absolute flux. What you'll get is relative intensities. In most of the case, this is largely 
enough. In some application, you may be interested by getting into the absolute flux. These will 
imply as well that your process for acquiring spectra is well under control (excellent guiding, good 
sky conditions).  

To get to absolute flux, you'll need to build the instrumental response from a reference star from 
which you'll know the absolute flux spectrum.  
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Visual Spec includes a library of absolute flux for 24 stars.  

 
It is suggested to re-determine the spectral response of the instrument each time it may be necessary:  
setup/breakdown, changing wavelength domain … 

1. Acquire the spectrum of one of the stars in the Visual Spec library. 

2. Process the spectrum like any spectrum, up to calibration in wavelength (needed). 

3. Click on the Radiometry menu, choose “Response…” 

4. Select the star in the list of proposed stars. 

5. Click on OK. 

6. The instrument response is added as the temporary series “RepInstru”. 

7. To save the series, replace one of the basic series with the series “RepInstru”. 

The instrumental response is obtained by interpolation of the profile in equivalent theoretical flux 
divided by the observed flux. 

The continuum fit is calculated automatically, but only in the range [4000 – 9000] – you'll need to 
have a wavelength range larger than 500 Angström or the application will not have enough points on 
the continuum to compute it 

The"absolute"  instrumental response can then be used to correct raw intensity profiles obtained 
under the same conditions. 

Flux calibration 
To correct the raw intensity of a spectral profile in order to determine the absolute intensity, it is 
necessary to calculate the instrument response following the method in the section “Absolute flux 
Instrumental Response”. 

Calculate the instrument response. 

Note: 
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Select the “Intensity” series. 

Divide the series by the series “RepInstru”. 

The temporary series “Division” is added to the list of series; it contains the contents of the intensity 
series corrected by the instrumental response. 

To save the series, replace one of the basic series by the series “Division”. 

Atmospheric extinction correction 
This correction only makes sense for excellent quality spectra and for very accurate measurements. 
It can only be performed once the instrumental response has been corrected. This correction has 
anyway small effect on the intensities. 

• Click on the menu Radiometry, choose Extinction 

A dialog box appears 

 

• Enter the Air section (Masse d'air) 

• Click on OK 

To obtain the Air section value, one can get it from the Speed Heliocentric calculation. See section 
Speed Helio. 

The Air section value is listed in the infos… window. 

 



Manuel de Référence Tools 
 
 
 

Visual  Spec Animation | 122 
 

C H A P T E R  7  

Tools 

A certain number of tools are provided to facilitate spectral analysis. 

To compare spectra, several methods are available: 

• An animation function allows viewing of changes over time of a set of profiles 

• Synthesis of the spectral image for comparison with the original image 

• Mosaic and batch formatting 

• Generation of a graph with superposition and shifting 

To identify different lines present, one can use a database of atomic lines of chemical elements.  
Some prohibited lines of oxygen and nitrogen are also included, as well as the position of the 
principal molecular bands of Titanium Oxide TiO. 

In some cases, it can be useful to compute the parameters of the best Gaussian fit to a spectral line. 

The open source Gnuplot application can be used to generate advanced plot of the profiles and be 
combined in the generation of a web page. 

For those who prefer keyboard commands, a special command-line console is available. 

It is also possible to get the coordinate of an object from the on-line Brigth Star Catalog. 

Animation 
Animation of a set of profiles allows viewing of the evolution of the same profile over time.  

Time scaled animation 
This animation function requires that date and time of the spectrum are correctly entered in the 
document profil header. 

Open the set of profiles containing the spectra of the same object, saved at different times. 

Normalize the profiles in order to compare the profiles using the same relative scale. 

Put all of the profiles into the same format, using the function “Apply Format” (on the Edit menu) 
and as needed using the function Y-Scale (menu Format, choose “Graphic…”, use tab “Axis Y), 
applied to all windows. 

Open the animation dialog box – the date and time will be read from the document header 

Click on the OK button to run the animation 
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Click on the close box to close the windows and go back to the application 

The files will be arranged by increasing time in the list before the animation starts. The overall 
animation time will the time in the "max duration" field. The number of loop in case of loop 
selection can also be modified. 

The animation is displayed in a separated window. The name of the file currently displayed is 
showned in the bottom of the animation window.  

You can run again the animation by clicking again the OK button. 

Date and time formatting 
The date and time shall have the following format: dd/mm/yy hh:mm:ss 

If the format is not recognized by Vspec, the files will be highlighted in gray in the dialog box after 
you clicked on the OK button 

 
To edit the date and time, select the file and double-click with the right mouse to make appear the 
edit field. 
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Edit the data and press the enter keyboard button to validate the data. 

None of the updates will be saved in the header of the file. If you want to save time the next time, it 
is much better to edit the file header directly with the header function in the Edit menu. 

 

Synthesis of spectral image 
Synthesizing a spectral image is creating an image reconstructed from the active spectral series, 
which may be the result of several processes such as composition or filtering a set of profiles of the 
same object. 

 
The grayscale values are determined directly from the Y scale of the series.  Several attempts are 
sometimes needed to obtain a synthesized image with good contrast. The image can be resize din 
width. 

This image can be then compared to one of the raw images that was used to create the spectral 
profile. 

When moving the cursor on the document profil spectrum, a white cursor will move on the spectral 
image at the corresponding position 
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To export, display the spectrum with colors corresponding to wavelength, or update the scale, 
display the popup menu by clicking on the right mouse button while the cursor is over the image. 

 

• Select the popup menu item Colorer (Color) to display the colors. 

 
 

• Select the popup menu item Exporter (Export) to save the image in the form of a .bmp  A dialog 
bow allows you pick the directory and the file name. By default, the file will have the name of 
the profile document followed by the suffix “-s.bmp”. 

It is now possible to match the scale of the spectral image to the wavelength domain of the 
spectrum. 

• Select the popup menu Update (Mettre à jour) to update the image display scale after a change 
in the spectrum profil scale change like a zoom. 

• Select the popup menu Close (Fermer) to close the window or click in the close box in the 
window itself. 

Coordinates 
This function is only available if the Excel application is installed. 

To find the coordinates of a star: 

• Click on the Tools menu, choose Coordinates 

A dialog box is displayed which asks for the name of the star to search for in the Bright Star 
Catalog. 
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The syntax to be followed when entering the name of the star to search for is the following: 

• Three first letters of the Greek designation:  Gam, Alp, Omi, Ome … or star number followed 
(without a space) by the three-letter constellation abbreviation . 

The result of the search is displayed in the Coordinates dialog box. 

 

The Bright Star Catalog is available in the form of an Excel file “brscat2.xls” in the application 
folder.  In addition to spectral type, it contains other information such as the coordinates, magnitude, 
HD reference. 

The profile file header is automatically updated with the values. If you want to keep the values 
recorded in the header, you'll have to save the file again.

Comparison 
This function is used to apply same formatting to the entire profiles load for an easier comparison. 

Load in Visual Spec all the spectra to be compared. We suggest using the command Tile in the 
menu Windows to automatically arrange the spectra in the Visual Spec application. 

Select the profile from which you want all the profiles to have the same format – mainly teh 
wavelength domain.  

• Click in menu Tools, sub-menu Comparison 

A dialog box is displayed if more than one prfile is opened in Visual Spec. 

Note: 
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The name of the profile which will serve as the reference is displayed at the top of the box 

Select the type of formatting to be applied 

• Normalisation: this will scale to 1 the continuum on the wavelength range defined in the preset 
– if the domain is out of the coverage of one the profile, Visual Spec will prompt the dialog box 
to entre new set of values. But will not change the previously adjusted profile. In this case it is 
better to repeat the process. 

• Adjust to maximum: look to the maximum value of each profiles. Align the max of the Y-axis 
of the each profile to this value plus 10% - all profiles will thus be displayed with comparable 
scale 

• Display axes: turn on the display of the graduations for both axis 

In addition the user can select text to be displayed in each graphic zone 

• Date: display the date of the observation, from the header 

• Site: displayed the site of the observation, from the fits header , or nothing if not a fits file with 
BSS_SITE keyword filled 

• Object: display the object name, from the fits header, or nothing if not fits file with OBJNAME 
filled 

• X%, Y%: value in percentage of the X or Y width where the text shall be displayed 

• Font size: size of the font to be used 

Hitting the OK button will format all the profiles according to the dialog bow settings 

Hit Close to close the dialog box. 
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This function is very well suited with BeSS query function to compare spectra evolution of a same 
object from the BeSS Datase 

Superposition diagram  
Another way to compare spectra is simply to superpose them and to shift them along the Y-axis. 

This can be done manually with the functions of Visual Spec but this function allows to 
automatically copy-paste and shift of a constant value each of the series. 

Before launching this function, it is recommended to proceed with the comparison function first. As 
described in the previous section, the comparison function can normalize each profile. 

• Click on the menu Tools, sub-menu Stack and Shift Y… 

A dialog bow appears, if more than one profile is opened in Visual Spec. 

 

• Enter the shifting constant which will be added to each copied serie for the stacking process 

• Click on OK to proceed 

Or  

• Click on Close to quit the function with no action 
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You can export the graph as bmp with the capture button on the right side or plot each series with 
gnuplot with the checked box "multi-serie" activated. 

Identification of chemical elements 
Identification of a chemical element based on wavelength is facilitated by the presence of a database 
included with Visual Spec. 

• Element.txt 

This a short version of the CRC Handbook of Chemistry & Physics - only lines from element up to 
Iron is reproduced. 
VI/16 Line Spectra of the Elements (Reader+ 1980-1981) 
Reader J. & Corliss Ch.H.  <61st ed., CRC Handbook of Chemistry & Physics (1980--81)> 

• lineident.txt 

This a formatted version of a catalog of lines in stellar objects 
VI/71A Revised version of the ILLSS Catalogue (Coluzzi 1993-1999) 
COLUZZI R: 1993   <Bull. Inf. CDS 43, 7> 

• sun.txt 

This a formatted version of the sun lines catalog 
J/A+AS/131/431 Accurate wavelengths in the Sun spectrum (Allende Prieto+ 1998) 
Allende Prieto C., Garcia Lopez R.J.   <Astron. Astrophys. Suppl. Ser. 131, 431 (1998)> 

• Hires 

The newly added "Hires" database if the transcription of the luke.lst file from Richard Gray's 
SPECTRUM software. It includes 38 text files and requires the 3.0.4 Vspec version at a minimum to 
be read as well as the separated zipped database file to be downloaded 

• Atmos 
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The file atmos.txt has been made by Christian Buil from various source of data: national weather 
forecast tables, observatories tables, and personal data from the professional Coralie Neiner. 

 

At the exception of Atmos and Hires database, all database are available from the Centre de 
Données Stellaire of Strasbourg, the CDS. By default, the database is the element list of the 
“Chemical Handbook”.  It includes only the wavelengths of the atomic elements for which the 
wavelengths are included between 3000 and 11000 angstroms. 

It is possible to add to the elements in this list by editing the file “Element.txt”.  It is suggested to 
follow the format of the database. 

To display the databases: 

• Click on the menu Tools, choose “Elements…” 

• or 

• Click on the button  from the toolbar 

A dialog box "Elements" appears 

Dialog box "Elements" 

 
 The lines of chemical elements whose wavelengths are included in the entire spectral area of the 
profile appear in the list. 
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• The column “lambda” gives the wavelength in angstroms of the line 

• The column “ion” indicates the ionization state of the atom. 

• The column “intensity” gives the laboratory intensity of the line. 

• The column “element” gives the chemical symbol of the atom. 

To close the dialog box, click on the “close” symbol of the window frame. 

You can click on one line and the cursor will move on the spectrum at the position of the element 
wavelength. If you do  not see any move, click on the profil document and then again on the element 
window. You can also use the "up" and "down" arrows. 

Identification by element 
To view the spectral lines by element, click on the column header “Element”.  The elements will be 
rearranged in alphabetical order. 

To return to a list ordered by wavelength, click on the column header “Lambda”. 

Identification over a defined domain 
To view the lines included in a defined spectral domain, enter into the textboxes “from” and “to” the 
values in angstroms of the first and last wavelength in the list.  Then click on the button “Find”. 

To return the all set of wavelength, click on the button  from the frame "list"  

Automatic identification 
Automatic identification allows automatic selection of the line whose wavelength is that defined by 
the cursor position. 

For this, it is necessary to: 

• Click on the selection box Selection in the list frame from the element window 

• Select a spectral area  

• Click on the database window to display the selection of elements in the list 

• To suppress the automatic identification mode, unselect the selection box 

When the cursor is within the selected area, between the gray dashed lines, the closest line to the 
cursor position whose wavelength is included in the wavelength domain plus or minus the sampling 
factor is automatically selected in the list. 

Multiple lines can be highlighted. This is due to low resolution of the spectrum which prevent the 
accurate determination of one unique line. 

This automatic identification is only an indication, and is highly sensitive to imperfections of 
calibration and resolution of the equipment. 

Spectral line link 
If the profile is calibrated in wavelength, and the user click at  a specific wavelength, the cursor in 
the element list  will move toward the line closest to the wavelength of the cursor in the profile. 

Note: 
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This function is given for indication, to move in the list in the “wavelength range” of the profile 
cursor. It shall be used to identified spectral lines. The resolution of a spectrum does not allow to get 
to the required accuracy to pick the line with certitude. The atomic element can be not present in this 
type of object and the sampling will probably encompass multiple lines.  

In the following example, clicking at the cursor position, the spectral line 6680.6 HO is highlighted. 
In reality, the line is the Helium line: 6678.15 HE  located above.  

 

 

Changing database 
To pick another database: 

• Select the database name from the dropdown list in the source frame 
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Element sorting 
To only see some of the lines of certain chemical elements: 

• In the “Elements” area, click the symbol of the element that one wishes to see. 

• Click on the button “Sort”. 

It is possible to select multiple entries in order to view a set of elements from the list. 

To re-display all the elements 

• Click on the “Reset” button  

Exporting a synthetic spectrum 
It is possible to only display the lines of one or several chemical elements, then to synthesize the 
spectrum of corresponding lines in order to superimpose it on existing series.  To accomplish this: 

• In the Elements area, click the checkbox in front of the elements illustrated in the list 

• Click on the button “Sort” 

• Once the list is created, click on the “Export” button to export it 

The synthetic spectrum is added as a temporary series named “spc.<chemical element symbol>” of 
the selected element. 

Verify and modify, as needed, the spectral extent of the list. 

Exporting a synthetic spectrum as a new document 
If the calibration process is not certain, it is possible to export the synthetic spectrum of a choosen 
element on the all spectral extent defined in the from/to fields in a separated profile document. 

• Click on the button  to export the list of lines of the element list as synthetic emission 
spectrum  

A new pofile document is created under the name "Newspc-<id>.spc" 

It is then very convenient to pick the interactive zoom and to search for evident correlation between 
lines pattern. 

Note: 
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Fast access to spectral lamp profile  
This can be useful to have a quick access to a pre-defined list of elements over a range of 
wavelength. The suggested usage is to list the wavelength of lines of a calibration lamp or the H 
Balmer lines.  User can define multiple preset of lines wavelength and get quick access to them by 
using text files. 

List_element.txt file 
To configure the fast access, the text file List_elt.txt shall be edited by ay word editor like notepad. 
This file shall be kept in the root directory of Vspec. 

The file will look as below 

 
Each line contains the name of the atomic element the user wants to see the lines wavelength and a 
wavelength range, each parameter separated by a coma 

Example: 

Ne, 5000, 7000 

will display the lines wavelength of the Neon element over the range 5000 to 7000 angströms 

To combine more than one element, the symbol & shall be used 

Symbols to identify the atomic element are the standard format in chemistry, as in a Mendeleiv 
table. Na for sodium, H for hydrogene, He for Helium, etc… 
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dialog box préférences – Tab Reference 

 
Each lines of the list_elt.txt texte file will the items of the drop-down list in the tab References. By 

selecting one will assign the configuration to the "lamp"  button which appears in the dialog 
bow "Elements"  
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Quick access in the Element dialog box 

 
Click on the lamp icon to display the lines wavelength associated in the preference menu.  

To change configuration, go in the drop-down list and pick antoher one of listed in the list_elt.txt 
file. 

 

To come back to the full list, over the wavelength domain of the current profile, click on  

To modify wavelength domain, type the new wavelengths "from:" "to:" and click on  

If the list_elt.txt file does not exist or if it is empty, then drop-down list will be empty. 
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Mendeleïev table 
Display the spectral lines of an atomic element from the Mendeleïev periodic table interface. 

This interface is displayed clicking on the   button. 

 
A new window is displayed. It represents the Mendeleïev periodic table. Only the atomic elements 
which have spectral ines in the selected wavelength range are enabled. Other elements are in gray 
and disabled. 
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To display the spectral lines of an element, click on it. A color will be assigned and will correspond 
to the color of the synthetic spectrum superposed to the profile spectrum. Multiple selections can be 
made. 

 
 

To cancel selections, click on the button   

The superposition of the spectral lines on the profile is not performed is no profile is displayed or if 
the profile is not calibrated in wavelength. 

To revert to the unsorted list of element, click on  

 

Hires lines database 
This database is extracted from the luke.lst file from SPECTRUM software. It includes all the lines 
retained by Richard Gray to generate theoretical spectrum. As this database is huge, it has been 
splitted in several sub files with 100 angstroms domain wavelength.  

You have to select the Hiresxxx file where xxx correspond to the domain wavelength of your study. 

If you did not have installed the hires.zip package, you will not see the files in the dropdown list. 
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Other aids to identification 
While the program is running, other calls to the database of atomic spectral lines can be made using 
the button containing the question mark. The chemical handbook database is used by default. 

• When calibrating in wavelength.  Then only the lines corresponding to the chemical body of 
calibration are displayed 

• During manual calibration.  Then the whole database is displayed in the list 

Gaussian fit 
In some occasion, it can be of interest to fit a gaussian with spectral line. Visual Spec can compute 
the gaussian parameter which will best fit the spectral line selected.  

Spectral line shape are defined by physics law. A gaussian profile is an approximation. The real 
profile is a combination of several physics process which can drive to more complex profile like 
Lorentz profile, Voigt profile combination, function of the energy level of the transition, the 
pressure, temperature, turbulence. Line can be also non-symmetrical, modified by Doppler effect of 
the matter. So computing some key parameters like Full Width mid-Height that way is not always 
relevant and drive to errors 

Simple extraction of a gaussian profile 
Open the profile and display the line you want to model - With the cursor select the portion of the 
profile you want to model with the gaussian fit 

• Go in the spectrometry menu and pick the gaussian fit item 

 
The gaussian fit will be computed and displayed as a new serie "seriename.gauss" with the orange 
colour 
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The parameters of the best fit gaussian are displayed in the infos window 

 

 
Outside the selected zone the profile is the same than the original profile 

The "bary" is the centre of the gaussian, the "FWHM" is the Full Width at mid height of the gaussian 

 
The modelization can also be applied to an absorption line 
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In some case, the algorithm will failed to get to the right gaussian. It can just display a continuous 
profile of an error message in the infos windows like "no convergence" or "MS=0", MS for mean 
square 

 
The fail can often be driven by  the aisle of the line not being at the same level. One option is to 
"flatten" the profile with a continuum correction or to move to a more complex model, by sub-range 
as explained below 

Zone modelisation 
The user can choose to fit only a portion of the line profile, which is closest to a gaussian curve like 
in the example below 
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Let's take a combined profile 

 
Due to the absorption centre in the line the best fit takes it into account and the overall fit is an 
average which does not exactly model the line shape. 

For a better fit, the user shall indicates to the function that a potion of the profile shall be eliminated. 

• Select the portion of the line you want to eliminate and click in the menu "operations", sub-
menu "zone elimination" 
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The portion of the profile will be removed and a direct line will connect the two border points - A 
new serie will be added, in cyan color. Its name will the previous working serie name + ".z" 

 
Keep selected this serie - select the overall line profile and perform now the gaussian fit 

 
You can see that the gaussian modelized profile fits much better the main line profile - you can have 
a better estimate now of the line centre and its FWMH 

If you want, you can perform another fit on the central portion, but pay attention of the border of the 
selection 
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GnuPlot 
The GnuPlot application is a "grapher", a free sofwtare running on Linux and Windows. To fully 
benefits from the powerful GnuPLot function, please refer to the website http://www.gnuplot.info/ 

You can also simply use the version which is installed by Visual Spec during its installation. 
* Copyright 1986 - 1993, 1998, 2004   Thomas Williams, Colin Kelley 
 * 
 * Permission to use, copy, and distribute this software and its 
 * documentation for any purpose with or without fee is hereby granted, 
 * provided that the above copyright notice appear in all copies and 
 * that both that copyright notice and this permission notice appear 
 * in supporting documentation. 
 **** 
 * This software is provided "as is" without express or implied warranty 
 * to the extent permitted by applicable law. 

 

Visual Spec uses the possibility to run GnuPLot by a command file and a script. 

Visual spec distributes the Version 4.0 but with only the mandatory file to run batch mode. To use 
the full application, one needs to get the official package from the official website. The Vspec 
distribution also includes specific file required by Vspec to run correctly GnuPlot like the command 
file "Gnutest.txt" and a script file "std.gnu". 

The style file "*.gnu" are in fact the GnuPlot scripts. It is a text file. You can edit and create other 
files, but shall give them the .gnu extension to be recognized by Vspec. 

• Click on the menu Tool, sub-item "Run Gnuplot" 

or 

• Click on the button    in the toolbar 

A dialog box is displayed 

http://www.gnuplot.info/�
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GnuPlot Dialog box 

 

• GnuPlot use the .dat file format to create the graph. If a profil with the .spc format is currently 
displayed, the .dat format will be automatically created and displayed. If the serie to plot is not 
the intensity serie, you need to replace the intensity serie by the desired serie before launching 
GnuPlot. 

• The style file is displayed in the frame "Style". If you want to select another file, click on the 

button  to open the "open file…" dialog box. 

• If you click on the check box multi-serie plot, all the displayed series will be plot in GnuPlot. 
Otherwise, only the Intensity serie will be plotted. 

• The image file name is indicated in the field "Image file name". The name can be edited. It is 
not required to add extension. The extension is automatically added by Visual Spec (.gif) or 
(.png) if the check box png is checked. 

• The field Title contains the text to be displayed at the top of the graph. 

• The frame parameters manage the limits and the graduations of the graph. 

- You can let GnuPlot select the best scale parameters by checking the check box Auto Y scale 
and/or Auto X scale 

- If these checkboxes are not checked, you have to specifies the Y and X limits. For X axis, the 
graduations spacing can also be specified. 

- If your script forces the X and Y values, these values will have no effect. 

• Once the parameters are defined, click on the button "Plot" to create the graph. 

• When GnuPLot has completed the script execution, a Pause dailog box is displayed 
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This box is managed by GnuPlot. It allows to keep the display on your screen, if your script is using 
it as a terminal. To close the GnuPlot window, click on OK 

 
 

• To close the Visual Spec GnuPlot window, click on the Close button 

File style "std.gnu" 
Visual Spec proposes a script file by default: "std.gnu" – it creates both a graph on the screen and 
record it under a .gif file in the same directory than the profile file. 

#============================================================ 

# Script de trace GnuPlot des profils spectro de Visual Spec 

#============================================================ 

# Paramètre 1 : nom du fichier 

# Paramètre 2 : intitul‚ du titre 

# Paramètre 3 : valeur min en Y 

# Paramètre 4 : valeur max en Y 

# Paramètre 5 : valeur min en X 
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# Paramètre 6 : valeur max en X 

# Paramètre 7 : valeur ticks en X 

# Paramètre 8: nom du fichier png 

# 

# Exemples : 

#    call "std.gnu" "140699.dat" "88Her" 6500 7000 .2 1.8 

#    call "std.gnu" "140699.dat" "88her" * * * *    (echelle automatique) 

#============================================================ 

 

set terminal windows "Arial" 9 ->  display the graph on the screen 

set xlabel "" ->  defines the x label, here, none 

set ylabel "" ->  defines the  y label, here, none  

set yrange [$2:$3] ->  defines the limits of the Y axis 

set xtics $6 ->  defines the space between X axis graduations 

set xrange [$4:$5]    # zone libre ->  defines the limits of the X axis 

set tmargin 2 ->  defines the margin around the graph 

set grid ->  Display a grid in the back of the graph 

set title '$1' ,-0.5 ->  dsiplay the title of the graph 

plot "$0" notitle with lines ->  plot the graph from the file 

#and now the file 

set terminal gif small size 640,480 ->  display the graph in a gif file format 

set output '$7' ->  save the file under the name $7 

set xlabel "" 

set ylabel "" 

set yrange [$2:$3] 

set xtics $6 

set xrange [$4:$5]    # zone libre 

set tmargin 2 

set grid 

set title '$1' ,-0.5 

plot "$0" notitle with lines 

 

The Gif format is more or less yet in the public domain. If you have difficulties, you need to check 
the png checkbox and modify the script std.gnu to replace set terminal gif by set terminal png Note: 



Required files 
Here are the files that Vspec needs to launch gunplot. All these files shall be in the root directory of 
Vspec.exe 

• Gnu.bat, DOS script file to launch script 

• Gnup.text, generated by Vspec, contains the directory path of the files to graph and the axis 
values 

• Pgnuplot.exe, Wgnuplot.exe, wgnuplot.mnu, executables 

• Std.gnu, style file for a single plot 

• Page.gnu, thumbnail style file for web page generation by Vspec 

 

Console 
The console (menu Tools, choose “Console”) permits execution control by command-line. 

The console is only accessible if the spectrum has been calibrated in wavelength. 

 

How to use the command-line 
To enter a command 

• Click in the console window 

• Enter the name of the command with or without associated parameters 

• To execute the command, press “Enter” 

If the command is not known, the error message “syntaxe inconnue” (“unknown syntax”) is 
displayed. 

If the command is not followed by the needed number of parameters, the message “nombre 
d’argument incorrect” (“number of parameters is incorrect”) is displayed. 

If one of the parameters violates syntax, the error message “Erreur syntaxe” will be displayed. 

To display the list of commands, enter “help ?”. 

List of available commands 
The command-line commands currently available are: 
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Command Parameters Description
Help ? Display the list of commands 
Help name of a command Describe the command 
Dir <none> List the .spc files in the current directory 
Cd Directory name or .. to go 

up one level 
Change the directory path 

Load filename Open the file <filename>.spc (the suffix .spc is 
automatically appended) 

Select windowname Make the open document in the window named 
“windowname” active.  If the document isn’t open the 
message “Erreur de syntaxe” is displayed 

Affichserie seriesname Make the series <seriesname> in the active document the 
active series.  If a series named <seriesname> does not 
exist in the active document the message “Erreur de 
syntaxe” is displayed 

Formatx real value L1 
real value L2 

Display the series of the active document between 
wavelengths L1 and L2 

Allformatx real value L1 
real value L2 

Apply the L1 to L2 wavelength domain to all open 
documents 

Norma real value L1 
real value L2 

Normalize the active series with, for area of continuum, the 
area included between L1 and L2 

Leq real value L1 
real value L2 

Calculate and display in the info window the equivalent 
width included between L1 and L2.  This calculation is only 
valid if the series is normalized 

Decoupe 
Crop 

real value L1 
real value L2 

Eliminate from the series the points outside the wavelength 
area included between L1 and L2 
If one limit is unchanged, use the "*" character as for Crop 
*, 6600 or Crop 6200, * 

Comp Operation: one character 
a:surface 
b:barycenter 
c:center of the line 
f:Fwmh 
i: intensity 
l:Equivalent Width 
m:mean 
s:snr 
l1: real value 
l2: real value 

Execute the operation between the value l1 and l2.  
Example: comp b l1 l2 
Compute the barycenter entre between the value l1 and l2. 

Plot <none> Call the gnu_plot dialog box – no parameter, plot the 
current active profile 

Loadim Image_name Load an image. If not extension is set, the default extension 
is the one defined in the preferences. 

Bin <none> On the active image, bin the image and create the 1D 
profile 

Binz Integer Y1 
Integer Y2 

On the active image, bin the image on the zone between 
Y1 and Y2 
Binz Y1 Y2 

Crop_pix Integer X1 
Integer X2 

On the active profile, crop the profile between the pixel 
value X1 and X1 
Crop_pix X1 X2 

S_rep Filename 
Filename_response_instru
mental  

Divide the intensity serie of the file filename by the intensity 
serie of the file filename_response_instrumental.  
It is not required to specify the complete path of the files. 
The response file shall be located in the same directory 
then the filename. The resulting file is saved under the 
name “filename_1c”. 

gaussfit  l1: wavelength Fit a gaussian to the profile section comprise between l1 
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l2: wavelength and l2 
serie_sel  
 

s1:integer Select the serie by its number s1 

Serie number s1 are coded as followed: 
- Intensity: 3 
- Ref1:4 
- Ref2:5 
- Normalise:6 
- added temporary series, incremented as they are added, 
first add start at 8 

div  s1:integer Divide the current active serie by the serie of number s1 
div_sel  Nomfenetre: string Divide the current serie of the current profile by the serie 

active of the profile in the window name nomfenetre 
cont_l  Compute the continuum from point list stored previously in 

the Liste.txt file 
cont_z  Compute the continuum by eliminating zone from the list 

stored previously in the Listezone.txt file 
smooth 
 

P1:integer Smooth by spline function the current active serie, the 
smooth coefficient is p1 
 

replace S1: integer Replace the serie of serienumber s1 by the current active 
serie 

run  nomprog.pgm: string  
p1:param  
p2:param 
p3:param 

Run the script nomprog.pgm, can support  3 parameters 

Zone_sup l1: wavelength 
l2: wavelength 

Suppress from the profile the intensities between the 
wavelength l1 and l2 

Serie_del S1: integer Delete the serie by its number s1 
Serie number s1 are coded as followed: 
- Intensity: 3 
- Ref1:4 
- Ref2:5 
- Normalise:6 
- added temporary series, incremented as they are added, 
first add start at 8 

Vhcor  Get  the Vhcor value from the fits header of the VO table 
file. Apply this speed correction to the whole profile. 
If the keyword is not present, display 0km/s and does not 
modify the profile 

Corratm Nothing 
l1: wavelength 
l2: wavelength 

If no parameter is following, then corratm iterated a 
theroretical atmospheric profile to fit the object profile on 
the wavelength domain 6540;6553 anströms 
If 2 wavelength are listed, then the iteration is done on this 
domain. 
The result is a changed intensity profile corrected from the 
atmospheric lines. 

7pts  Launch the 7pts "point and store" function, as if clicked 
from the menu 

Comp7  Same a comp but used the first and the last wavelength 
values from the list7pts.txt file 

Save_infos Filename Save the data displayed in the infos windows under the file 
named filename and replacing breakline by tab character to 
have all data on one line 

W_bk  Write and force a break_line character in the infos text  
Write String Write a string on the infos text – do not use space in the 

string 
w_jj  Write the date in Julian days in the infos text 
W_samp  Write the sampling factor in the infos text 
Line1  Generate and display a line which Y axis is one 
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Windows docking 
User can dock the following windows on the right side of the application 

• Window element 

• Window infos 

• Window console 

The application interface will look like: 

 
To dock windows, click and keep push on the left mouse button until the cursor will look as below.  

 
The "drag-and-drop" docking mode will be activated if clicked in the window gray area, outside of 
frames. Exemple of location to click are shown for each window 

• Window element 

 

• Window infos 
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• Window console 

 
 

Drag-and-drop the cursor on the new grey side of the Vspec application. When drop is allowed, a 
black rectangle appears close to mouse location. 

 
To un-dock the windows, click and drag-and-drop them on the yellow part of Vspec interface.  

If your computer screen is too small, dock only the useful windows. Make a test. 

Sequence timing 
In BeSS database, the exposure duration definition is not the total exposure of the spectrum as the 
sum of the individual exposure of each image in the sequence. 

The BeSS exposure duration is defined as the overall time period where the images were recorded. It 
is computed as the date & time of the end of the last image – date & time of the beginning of the 
first exposure. This has to be in Universal Time. 

To facilitate this operation, the user can now select the list of the images of the sequence and let 
Vspec extracts and compute the timing and date. 

The functions works with Pic or Fits format file. It does not work with dat, as the .dat format does 
not have any header informations. 

Get to the function 
To access the function: 

• Menu Edit, sub-menu Header – in the header dialog box, button Seq 
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• Menu Export fit – in the BeSS format diaolog box, button Seq 

 
When clicking on the Seq button, the Open Image Dialog box opens: 
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• Select the images which belong to the sequence of observation 

• Click on the "Open" button 

The dialog box will close 

• The result of the computation is automatically updated in the header dialog box 

 

• Or in the BeSS dialog box 
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• Result and details are displayed also in the Infos window 

 
The name/date/time  of the first image and the name/date and time of the last image of the sequence 
are displayed – First and Last are found based on the exact  date and time from the image header. 

The date/time of the first image, in Universal Time is computed and the total overall exposure 
duration is computed following the definition of the BeSS specification.  

You'll have to make sure that your list effectively includes the first and last image of the observation 
sequence 

Preset the UT time 
To define the local time, you'll have to define in the Preferences what's the time difference Vspec 
will have to add to your images time flag. If you have set-up your images acquisition process in 
Universal Time, set UT+0 – if not, then select your offset in the preference "position" tab. 
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Internet page generation 
This function is a tool to generate a web page with all the spectra of the currently opened documents 
as gnuplot graph. 

• Click on menu Tools, sub-item Page... 

Dialog box Internet Page Generation 

 

• Enter the name of the sub-directory in Vspec directory. If the directory does not exist, it will be 
created. If the directory exists, the content will be replaced by this new page generation 

• Enter the title which be printed at the top of the page, in blue, larger font 

• Enter the number of graph per line.  

The size of the graph generated will not change. They will also be as described in the style file 
"page.gnu" – by default it is:  

set terminal png small size 340,260 
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To modify the style of the graph generated by gnuplot, directly edit the file "page.gnu" wich 
contains the batch list of gnuplot commands. The file "page.gnu" has to be found in the same 
directory as Vspec.exe. 

• Enter the wavelength range for all the graphs and the number of ticks between labeled ticks 

In the created sub-directory, the generated page is named vspec_objet.htm. All the documents will 
be converted into dat files and will be stored in this directory. All the images will also be generated 
and stored there, with generic names img x.png 

The directory can be moved at anyplace on the hard disk. If not moved, next call for new page 
generation will erase the previous one if directory name is not changed. 

 
 The html page can be edited for customization. 

This function is powerful if combined with the comparison tool, and the BeSS query. In few clicks, 
it can generate a web page with the spectra of a star over time with same format and scale for quick 
visual comparison. 
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C H A P T E R  8  

Assistants 

The assistants are evoluated functions or link to external applications to assist the user in performing 
a sequence of processings in a more automated way or to get access to additional informations 
through internet connections to public database. 

Lhires based assistants 
Those assistants have been developed to fulfil the need for Lhires spectrograph users, but can be 
used also with images acquired with other devices, as long as some rules are respected, as explained 
all along this section. 

The Vspec assistants follow the convention of file naming suffix which describes the level of 
processings, defined by Christian Buil in his tutorials (see 
http://astrosurf.com/aras/tutorial1/pipeline.htm )  

• 0b, 0c: Image file, one spectrum per image, all pre-processings done, ready for the 1D profile 
extraction 

• 1b: profile file, wavelength calibrated 

• 1c: profile file, 1b + correction of the instrumental response 

• 2a: profile file, 1c + correction of the atmospheric lines 

• 2b: profile file, 2b + continuum correction 

 

The two assistants can be found in a new menu "Assistant" 

• if no profile file is opened 

 

• if a profile file is opened 

 

http://astrosurf.com/aras/tutorial1/pipeline.htm�
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0b_to_1c – starting with the image 
This assistant extracts the spectral profile, calibrate it in wavelength and corrects it from the 
instrumental response of the sensor. The resulting profile has the level of processing required and 
sufficient to be converted into fits format. (ready to be load in the BeSS database in case of a Be 
Star) 

The assistant load the object image, the calibration lamp image and the response curve of the device. 
It detects the spectral lines of the calibration lamp and calibrates the profile using a pre-written list 
of wavelength from a text file  

The response curve shall have been pre-established and saved as a spc file with the response profile 
in the intensity serie. 

The wavelength list is read from a text file that the user shall specified 

This function has been developed for spectra acquired with a Lhires spectrograph. It can be used 
with any other spectrograph as long as the following conditions are met: 

• the calibration process uses a calibration lamp 

• one spectrum per image 

• The response curve of the instrumental behaviour has been processed and the wavelength of the 
lines in the lamp spectrum are identified 

Dialog box "Calibration script Lhires" - description 

 

• Object file: name of the image file, without its extension – click on the icon on the right to 
select the file if required 

• File lamp calibration: name of the file of the calibration lamp, without its extension - click on 
the icon on the right to select the file if required 

• The extension is the default extension defined in the preferences 

The degree of the polynome is forced to 2, whatever the user selection is 

The directory is the default directory or working directory chosen in the preferences. 

•  Instrumental response: name of the profile file of the instrumental response, without extension - 
click on the icon on the right to select the file if required 
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This profile file shall be a spc file, and the first serie intensity shall contain the response curve. This 
response shall cover the wavelength range of the profile to correct. 

• Lambda: Wavelength list of the calibration lamp spectrum – this list shall be load with the xx 
bouton – it calls for a dialog box to select the .lst file which resides in the vspec root directory 

The wavelength list shall correspond to the spectral lines visible on the lamp spectrum. They shall 
be ordonated from the blue to the red. (increasing wavelength) 

To create this list, it can be done with the multi-lin function, editing the wavelength (or selecting 
them from the element window if displayed) then by saving the list in a .lst file. This file can also be 
directly edited with a text editor like notepad. See the Vspec manual and the example below. 

 

Operations description 
Vspec will first load the two images. It will extract the 1D profile with the automatic binning 
function and the result is put in the intensity serie. 

It will then do the "lamp binning" on the lamp image and put the result in the "Ref1" profile. 

Vspec then detects the lines of the lamp profile. The assumption is made that all lines are emission 
lines (detection of maximum) and that the width is around the one defined in the preferences, as 
shown in the image below. 

 
Once the lines are detected, Vspec assign the corresponding wavelength in the same order from the 
.lst file. Line 1 is associated to the first wavelength, line 2 with the second, up to the last line. The 
calibrated profile is saved with the "_1b" extension. 

Vspec will then load the instrumental response and divide the object profile by this response, and 
will replace the intensity serie by the division result. This new file will be saved with the extension 
"_1c" 
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The profile files will be kept displayed for a check. It is not necessary to save them again. Except if 
you make modifications. 

 
The wavelength and their corresponding barycentre with the coefficients of the calibration law are 
displayed in the infos window. 

 

Console mode 
This assistant is also accesible though the console with a command line. 

A wavelength list shall be previously created which will contain the wavelength of the lines of the 
lamp spectrum, as in the menu assistant. This file shall have as above the .lst extension. 

The command is the following: 

s_calrep nom_image nom_image_neon nom_profile_instrumental 
nom_fichier_liste 

None of the file name need to be written with its extension. The extension is by default the one 
selected in the preferences. 

All the files shall be present in the working directory, specified in the preferences with the exception 
of the list file which shall reside in the root directory of Vspec 

Example 

In the working directory, the following files are: 

t4Crb_2.pic for the image of the object 

t4Crb_neon_2.pic for the image of the calibration lamp, here a neon lamp 

Instrument.spc for the previoulsy computed instrumental response 

neon_lhires.lst for the wavelength list of the neon lamp 

6506.528 
6532.882 
6598.953 
6678.276 
6717.043 



Manuel de Référence Assistants 
 
 
 

Visual  Spec Lhires based assistants | 162 
 

The line command is: 

S_calrep t4crb_2 t4crb_neon_2 instrument neon_lhires 

 

1b_2b – Starting with a calibrated profile  
This assistant links the following processings starting from a calibrated profile (wavelength 
calibrated "_1b") 

• correction of the instrumental response "_1c" 

• correction of atmosphéric lines "_2a" 

• correction of the continuum "_2b" 

These processings requires user intervention, but are linked automatically the stand-alone 
processings.  The assistant saves all the files with the appropriate extension corresponding to their 
level of processing. 

Dialog box "assistant script" - description 

 
It is possible to desactivate one of the processing in the chain by clicking on the icon facing the 
processing name in the list script. 

• generic profile file name: select the file from the directory with the right button or type the 
name without suffix "_1b"  

In the open file dialog box, only file with extension "_1b.spc" are listed. 
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• Instrumental response file name: select the file from the directory with the right button or 
type the name without the extension .spc  

• Click on Run 

Visual Spec will automatically launch the processing listed. Some of them requires user actions. 
Refer to the stand-alone description of the processing in Vspec manual 

Operation description 
Vspec opens the file "generic_name_1b.spc" and corrects it with the profile from 
"response_name.spc". Result is saved with the extension "_1c.spc" 

Vspec launches the atmospheric line correction processing. Refer to Vspec manual. Once the 
correction adjusted, click on ok in the atmospheric dialog box. The result will be saved with the 
extension "_2a.spc" 

If the atmospheric line correction has required a shift in the wavelength, then at closure, Vspec 
applies the shift to the instrumental response profile and redo the response correction. (and save 
again the "-1c.spc" file. 

Finally, Vspec will launch the continuum correction, which will divide the profile by its own 
continuum. Refer to Vspec manual for continuum correction user actions description. Vspec will 
save the result in a file with the extension "_2b.spc" 

If one of the processing is disabled by the user, Vspec link the next enabled processing based on the 
suffix of the last executed valid processing. 
Vspec also automatically crop the profile by detecting values close to zero. 

At the end of the assistant execution, All the files "_1b.spc", "_1c", "_2a", "_2c" are displayed for 
checking 

If files are not found, or errors occur, information messages are displayed. There is no command line 
in the console mode available for this assistant 
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Console script mode 
The console allows you to enter command lines. It is now possible to link them into a text file and 
run this as a script to automatize some processings.  

Automatization of spectral processing shall be done with care. Make sure your results are consistent 
and as accurate as the manual process. 

How to build / run a script  
-Test your command sequence first in the single command mode in the console  

-Open a text file, edit the command list, one command by line, up to 3 parameters $1, $2, $3 can be 
used  

-Save the text file with a .pgm extension - the file shall be stored in the vspec.exe directory  

-Run the script from the console by typing run nompgm (without .pgm) and the parameters if you 
have included them  

Script example  
In this example, the script will load the $1 file, perform a zone continuum correction followed by a 
spline smooth with $3 smooth coefficient, select the intensity serie and divided it by the serie "8" 
which is the added serie "continuum.fit". It then normalize the profile, move the current serie in the 
intensity serie, save the file under the $2 name and reload it to display the result 

load $1 
conti_z 
smooth $3 
serie_sel 3 
div 8 
norma 6590 6640 
replace 3 
save $2 
load $2 
 

Define the extraction continuum zone 
 
The most important to know here is to have previously stored the list of profile zones to eliminated 
before the continuum fit on a previous profile, this having being done the traditional way. The same 
way, the smooth coef $3 would have been determined from another similar object processed 
manually. It may not be absolutely the same from one profile to another one... that's the limitation of 
automatisation. 

Pick  the profile which exhibits the highest number of lines, to make sure all the zones where lines 
can be present are captured and eliminated.  

This profile is then processed "manually" - first, extract the continuum 
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Then, eliminate the zone where there are lines 

 
When done, just run the continuum extraction, and get the smooth box displayed - pick and note the 
smooth coefficient 

 
Stop here, or go up to the end, just to check that your process will be ok 

Run the script 
Display the console 
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Enter the command to run the script with the name of the file to process as parameter 1, the name of 
file under you want to save the result as the second parameter and the smooth coefficient, which is 5 
(the highest it is the smoother it will be). Run... and observe the sequence, at the end, the file with 
the resulting processed spectrum is saved and displayed. The list of commands executed are printed 
in green in the console. 

 
You can repeat the script entering new object names - you can just edit the names on the same line, 
then select only few characters of the line and hit enter - the command will be run again. 

 
You can also cut and paste to repeat the same script in a long text file with the different names of the 
object you want to process. And run just once 

Script box 
This allows running a script on a list of files from different directory, dropped in the list box. 
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Click on the menu "assistant" sub-item "Script-box" 

Script box dialog box 

 
 

• The left white box shall show the files to be processed by the script 

• Windows Explorer  : open Windows Explorer. The user can select the directory and the 
files to be processed by the script. Drag and drop them in the file section of the dialog box. 

• VisualSpec Explorer   : open the Visual Spec Explorer interface. Drag and drop the 
thumbnails of the files to be processed by the script.  

• If profiles are already opened  in Visual spec, click on the  button to add  them all to the 
list of files to be processed. 

• The open file icon is to open the directory of the script .pgm file to run on each file in the list 
box 

• When the .pgm file is loaded the script is displayed in the blue section  

• If the script requires paramaeters, enter them in the parameter text field 

• Click on Run to execute the script on the files 

• Always start a script with the command Load $1 

In addition 

• you can save back the script if you edited it  

• Clear the list of files with the blue  arrow button  
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• Get a description of the command line available with the button , then click on the 
command to have the desciption in the dialog box 

 

Examples 
Script to link the plot gnu_plot feature and generate the png graphics 

load $1 
plot 

Script to compute the Equivalent Width on a pre-defined wavelength zone 

load $1 
norma 6590 6600 
comp l 6547 6577 

BeSS queries 
Visual Spec includes a tool to query and import spectra from the professional database « BeSS », for 
Be Stars from the Paris-Meudon – GEPI observatory.  

You need an internet connection. 

To make a query go in the « Assistant » menu, item « BeSS query ». 

 
A dialog box is displayed 



Manuel de Référence Assistants 
 
 
 

Visual  Spec BeSS queries | 169 
 

BeSS Query dialog box 

 
 

Enter the name of the star which you are looking for spectra in BeSS. The name format shall meet 
the BeSS format and shall respect the use of  lower/upper case.  

• For an HD star, enter HD followed by its number 

• For a name like bet Cyg : the first three characters of the greek letter are in lowercase, then a 
space, then the abreviation of the constellation name with always the first one in uppercase and 
some followings: ups Sgr, kap UMa, bet CMi. 

• If a fit file is already open and you want to search spectra from the same star, click on the small 
button next to the object text field. 

 

• Launch the query by clicking on the « query » button. 

BeSS database returns a message showing the number of spectra found.  

 
If this number exceeds 1000, no spectra are returned, the list stays empty. You need to reduce for 
example the time period of the search, using the “period” section or change the wavelenght.  

• Fills the text fields, or use the predefined button “from one year” or “today” to quickly reduce 
the time range. 

• To get only spectra which contains a specific wavelength, enter the wabelength in the text field.  

• A button "H-alpha" allows a quick fill of the H-alpha wavelength at 6563 angström 

• To erase data in all the text fields, click on the buttons  

The files found in BeSS are listed in the list zone.  

• Click on one of the spectra to open it directly in Visual Spec.  
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• To open all the listed spectra, click on the “display all” button. 

• To not open some files, unclick the selection box in front of the file name 

• To unselect all the files in the list, click on the "none" button, then only select the files you will 
want to open with the "display all" button 

• To reselect all the files, click the check box "All" 

• To display the files by date ascending order or descending order, click on the date column. 

•  

BeSS files are stored in the BeSS_VO directory – clear this directory from time to time. 
Fits file are in fits VO table format. This is the standard format defined by the “Virtual Observatory” 
group and are not largely supported by other software. Applets can be found on the net. 

Hiding – sliding 
Instead of closing the window, you can simply mask it and put it at the bottom of the application, 
where it will be easy to recall only by passing the mouse over the remaining border. 

To mask the window, click with the right mouse button inside the BeSS VO dialog box, not on a 
control 

 
A context pop-up menu will appear, click on "mask". Each time the cursor will move on the yellow 
section of the application the dialog box will move down to the application and appears with just a 
grey border. 
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Move the cursor over the grey line and the query box will slide vertically and re-appear. 

BeSS spectrum validation 
The validation of a spectrum for its acceptance in the BeSS database, requires several operations to 
be performed. This command linked them to speed up the validation process for spectra centered on 
the h-alpha line. 

• Click on the  button on the side toolbar of the document. 

The application will perfomed the following operations: 

- Superimpose the atmospheric spectrum, to check for concordance of the telluric lines with 
the observed spectrum 

- Display the fits header, to check the validity of the date, time and other key words 

- Zoom on the region between 6440 and 6700 if the spectrum is going beyond those limits 

- Read the fits keyword OBJNAME and use it to query the BeSS database 

- Display the last 2 spectra from this object load in the BeSS database in smaller windows 

 

 
 

If no spectra from BeSS are displayed, this may indicate that there is no spectrum of this object in 
the BeSS database. 



Manuel de Référence Assistants 
 
 
 

Visual  Spec Edit Vspec txt files | 172 
 

If the objname is not meeting the VO query rules, no object will be found. Chek the Objectname 
format – the first letter of the constellation name shall in uppercase.    

 

Edit Vspec txt files 
Visual spec used several text files for saving pre-settings or configuration or styles. This command 
allows the user to open directly the text file for editing without going out of visual spec and open the 
file from the Vspec directory. 

• Click in the menu Assistant, sub-item Edit… A list of files as new subitems list is displayed. 
Pick the one you want to read or edit. Will launch notepad. 

The files which are editable are: 

- Std.gnu: style file to generate gnuplot graph 

- Page.gnu: style file to generate the thumbnails of the Vspec web page tool 

- Infos: open infos.txt, the file which contains the data displayed in the infos windows, when 
user has click on the save button 

- Liste: open liste.txt which contains (if any) the latest saved wavelength points list to extract 
continuum 

- Liste7pts: open liste7pts.txt file which contains the wavelength and intensity of the 
memorized points with the 7pts command 

- Continuum: open the continuum.txt which contains the 2 wavelength which delimits the 
average computation of the profile to be used as scaling factor 

- List_intru: open the list_instru.txt file which contains your list of instrument for BeSS 

- List_obs: open the list_obs.txt file which contains your list of preset observatory site names 
for BeSS 

 

CDS queries 
To directly check the Simbad database to get more information about an object, use the CDS query 
command. 

• Click in the menu Assistant, sub-item CDS query 

Or 

• Short-cut F3  

A dialog box is displayed 
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If the name is correct, the internet browser will display the request result. If the name is not 
recognized as an official identifier, the web page will indicate an error. As recognized identifer, one 
can enter the bayer name like alpha lyre, or bet Cas, or the HD number format or for the brightest 
star their popular names like antares or vega … 

 
Click on the small square button to recall the objname of the active fits file if one is displayed into 
the application  

Link with SPECTRUM software 
Visual Spec allows you to directly use the SPECTRUM software by providing a user-friendly 
interface using the script facility of the SPECTRUM software. R.O. Gray, the author has accepted 
that Visual Spec get linked to his application. 

Refer to the section on Spectrum on Visual Spec website 
http://astrosurf.com/vdesnoux/spectrum.html 

Also this link will provide more explanations on the models name format and the bibliographic 
references: http://astrosurf.com/vdesnoux/models.html 

This requires that you have correctly installed SPECTRUM and declared it in the preference dialog 
box, if it was not correctly installed automatically by Vspec at its installation. 

http://astrosurf.com/vdesnoux/spectrum.html�
http://astrosurf.com/vdesnoux/models.html�
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Preference settings for SPECTRUM  

 

• Select the tab "spectrum" 

• Select the hardrive and the directory where spectrum.exe is installed 

• Click the option button "Yes, Spectrum is installed" on the right frame 

This will become the referenced path for Visual Spec to find the executable of SPECTRUM. If you 
change this directory, make sure you update the preferences settings in Vspec again.  

If you did not have installed Spectrum and not selected the installation path, the Run Spectrum 
sub-menu will not appear in the Options menu. 

• Click on the Run Spectrum sub-menu in the Options menu to get access to the SPECTRUM 
interface and run SPECTRUM 



Manuel de Référence Assistants 
 
 
 

Visual  Spec Link with SPECTRUM software | 175 
 

SPECTRUM interface dialog box 

 
You have to enter the parameters required by SPECTRUM to run correctly. 

• Enter the Atmosphere model. Either you type directly the file name or you click on the side 
button to open a "open dialog" box 

 
Only the files with extension *.mod will be listed.They shall meet the SPECTRUM atmosphere file 
format as described on its web site. 

• Enter the turbulence velocity – usually this value is known from the name of the model you 
picked 
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Usual convention for model file names 
45045k4p00.mod 
450: 4500°K temperature 
45: log(g)4.5cm/sec² 
k4: 4km/s turbulence velocity 
p00: metallicity [M/H]=0.0 (solar abundance) 
m05: [M/H]=-0.5 (0.32 x solar abundance) 
p05: [M/H]=0.5 (3.2 x solar abundance) 
 

The model files shall be find on the web, mainly from Kurucz site. (See Vspec site). 

• Enter the start and end wavelength 

• Enter the wavelength steps – use 0.01 angström as a minimum value 

You can compute the number of points in the output files by clicking on the "Nb points" button. This 
is useful to prevent too huge file generation. 

Vspec can only manage 16382 points spectrum file.  

• Enter the name of the output file – the file format will be a "dat" file (two columns: wavelength, 
intensity) – You can select the directory and the file name by clickling the side button. 

 
Here is an example of the window correctly filled 

Note: 



Manuel de Référence Assistants 
 
 
 

Visual  Spec Link with SPECTRUM software | 177 
 

 

• Click on the OK button to launch SPECTRUM  

A small script is written on the hardisk and then executed by SPECTRUM. The DOS windows of 
SPECTRUM execution is temporary displayed over Vspec 

 
Once the execution is completed, the synthetic spectrum is automatically displayed in Visual Spec 
and saved as a "dat" file. 
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A great Thanks to Richard Gray who wrote SPECTRUM free software with adequate 
documentation and script function… 

Spectrum and models linked to spectral type 
The interface of Spectrum also includes a link to a table which will make easier the correspondence 
between models and spectral types, pointing the effective temperature and density.  Click on the “by 
spectral type” button. 

 
The spectral type models window is opened: 

Note: 
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For a given spectral type, the corresponding model is highlighted by a red arrow. If intermediate 
spectral types are looked for, pick one of the closest models which are available (with gray circle) 
based on their temperature.  

Click on the desired model. Its name will be automatically put in the text field of the Spectrum 
dialog box. 

 
Complete by entering the other parameters.  
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C H A P T E R  9  

Spectral Analysis 

Spectral analysis consists of processing the data of a profile calibrated in wavelength in order to 
extract significant spectroscopic information.  This chapter describes various strategies for 
processing and spectral analysis. 

The first application consists of comparing spectra with each other, or with spectra of the same 
object having changed over time.  These comparisons are qualitative. 

A second application consists of a quantitative comparison of certain measurements such as 
equivalent width or Doppler shift. 

Finally, it is always interesting to try to identify different spectral lines of an object a posteriori.  

To complete the analysies, Visual Spec provides use a user friendly link to the SPECTRUM 
software from Richard Gray. This software can be download from the web site xxx. SPECTRUM 
allows you to generate theoretical spectrum of a star knowing physical parameters like temperature, 
pression… To have an extensive description of SPECTRUM usage, please refer to Vspec web site in 
the "theoretical spectrum" section.

Comparison of spectra 
To compare spectra with each other, it is necessary to first perform operations of correction and 
normalization so the spectra are really comparable with each other. 

These corrections are: 

1. Calibration in wavelength:  needed 

2. Radiometric: suggested if the spectrum extends over a spectral domain sensitive to the 
difference of the sensitivity to wavelength of the sensor. 

3. Normalization with respect to the continuum:  done so that the calculation of the continuum 
is carried out on the same wavelength domain of both spectra and to ensure that no lines are 
present in this area 

One can compare several spectra: 

• By simple superposition, by Cut/Paste, even if the samplings are different (see section 
“Cut/Paste of a spectral series”). 

• By animation, after having applied the same format all spectra to be compared. 

• By division, the signature of a difference having resulted in a line outside the noise in the 
vicinity of the difference. 
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Quantitative parameters 
If the spectra are sufficiently resolved that the shape of a line is not solely dependant on the 
characteristics of the equipment, it is possible to measure and compare: 

• Equivalent widths of lines 

• Doppler shift 

• Speed of expansion 

Equivalent width 
To follow the evolution of the same line over time, calculating the equivalent width gives an 
indication of the power of the line.  If the equivalent width changes, this indicates changes in the 
physical conditions of the layers that produced the line. 

An example of evolution of the line H<alpha> of 28 Tau (B8Ve) 

1. Search with the File|Find function for all the profile documents containing “28Tau” in their 
comment area. 

2. Open the documents. 

3. View the set of spectra using the function Window|”Small Windows” 

4. Select one of the spectra, and apply the same format to the others (Format|”Graphic…”|”Axis 
X” and check “Apply to all windows” and then click “Apply”). 

5. Verify the predefined area for calculating the continuum in the “continuum” tab of the 
Options|“Preferences…” dialog box.  This area should be common to all the spectra and 
should not contain lines. 

6. Normalize each of the spectra (Operations|Normalize). 

7. For each spectrum, select the line to measure and choose the menu item Weq (Equivalent 
Width) in the Spectrometry menu.  The result is displayed in the “Infos…” window below the 
name of each document. 

8. Click on the “Save” button of the “Infos…” window. 

9. Open the file Infos.txt in a text editor. 

LEQ: 37.91 
15p004.spc 
LEQ: 34.68 
14p005.spc 
LEQ: 32.54 
12p009.spc 
LEQ: 31.66 
11p007.spc 
LEQ: 30.55 
09p021.spc 
LEQ: 22.92 
06p015.spc 
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Doppler shift 
Measuring the Doppler shift requires a bit of care because it is based on the measurement of 
deviation in wavelength of a line with respect to its theoretical position. 

It is impossible to perform this measurement if the spectrum was calibrated in wavelength based on 
its own lines. 

The Doppler shift to be measured must also be from 2 to 3 times more significant than spectral 
sampling. 

For very accurate measurements, correct the spectrum from the doppler shift from Earth moving.  
See the section "Helio Speed correction" 

It is also possible to graduate the X axis in doppler shift  (km/s) centered around a reference 
wavelength value. 

To measure a Doppler shift: 

1. Calibrate the spectrum carefully using an external reference spectrum. 

2. Select the line to measure. 

3. Calculate the center of the line; the position is given in angstroms. 

4. Calculate the ratio:  Measured Position – Theoretical Position / Theoretical Position. 

5. Multiply by c=3,000,000 km/s to obtain a shift in km/s. 

Example of a detail of the line H<alpha> of 59 Cyg (Ble) 

 
center1: 6559.47 
center2: 6564.61 
center: 6562.33 theoretical position at 6562.852 
FWMH: 12.76 
12p010.spc Ech= 0.286 A/pixel 
 
Yields: 

• Shift 1 = (6559.47 - 6562.852) / 6562.852 * 300000= -154.6 km/s 

• Shift 2 = (6564.61 - 6562.85) / 6562.852 * 300000= 80.6 km/s 

• Resolution = (0.286) / 6562.852 * 300000 = 14 km/s 
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A precise measurement should take into account the Doppler shift due to movement of the Earth in 
its orbit.  This calculation is available with the heliocentric speed correction function. 

Speed of expansion 
As for calculation of Doppler shift, this measurement demands the same precautions for calibration 
and resolution. 

The measurement of speed of expansion or rotation is defined by increase in the line caused by the 
Doppler effect. 

1. Calibrate the spectrum carefully using an external reference spectrum. 

2. Select the line to measure. 

3. Measure the center of the line, the position is given in angstroms 

4. Measure the full width at half-maximum of the line:  FWMH. 

5. Calculate  FWMH/center 

6. Multiply by c=3,000,000 km/s to obtain shift in km/s 

Example of the nova Cygnii 1995 

 
center:  6562.75   
FWMH:  43.92  
tnvcy-48.spc 
 
Yields: 

• Speed = (43.92) / 6562.852 * 300000 = 2008 km/s

Identification of elements 
The identification of element is a difficult exercise.  It is not a question here of discoving new 
elements, but to recognize well the original chemical elements of the lines observed.   

Ability to identify with precision which chemical element produces which line depends largely on 
the resolution.  Indeed, a great number of lines of various elements are possible in a very small 
domain of wavelength, such as shown below in an area of 10 angströms / 1 Nm. 

Note: 
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It is necessary to research, referring to the literature, to gain preliminary knowledge of the physical 
conditions of the object of study, with reference to its spectral type. 

A useful technique consists of superimposing the theoretical spectrum of the presumed elements in 
order to verify whether they correspond to the lines. 

Click on one the line to see the profile document cursor moving at the line wavelength on the active 
serie. If no move is observed, click on the profile document then come back in the element list. You 
can also move the line selection by using the up and down keyboard arrows. 

Solar spectrum 
Example:  Solar spectrum and lines of Sodium, Na.  One can recognize the double of Sodium, at the 
left. 
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Superposed with the lines of Iron, one sees some correspondence. 

 
Superposed with the lines of Calcium. 

 

Stars of spectral type M 
Example of a spectrum of an M star, 10 Dra (M3.5III) with the start of lines of TiO 
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Planetary nebula 
Example of the spectrum of a planetary nebula M57 and missing lines (NIII). 

 

Atmospheric lines 
Atmospheric lines have a characteristic profile and are easily identifiable.  They can be used for 
spectral calibration. 
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A P P E N D I X  1  

Quick Reference Guide 

Quick reference card 
 

Open Image

Open Profile

Reset image thresholds

Reverse Right/Left image

Binning object

Binning calibration lamp

Calibration 2 lines

Calibration 3 lines and +

Active serie

Change color of the active serie

Modify scale Y - X

Zoom/Cancel zoom on the zone selection

Copy the active serie

Paste the active serie

Crop the profil to the selection

Move serie position in the list

Reference to 1 the continuum, zone defined in 
the preferences

Calculation on selection, calculations 
defined in the preference measure

Division of a profil by another one

Correction of atmospheric lines

Call grapher GnuPlot

Display database of elements

Decrease max value of Y axis

Increase max value of Y axis

Link series

Apply same scale to all serie

Display axis graduations

Erase all except series

Atmosphére

Néon Véga

Short-cut

Del/Suppr Delete the active serie, if temporary serie
Ctrl+D Divide the active serie by another one
Ctrl+E Database of element wavelength
Ctrl+Q Console mode
Ctrl+W Convert into fits "BeSS"
Ctrl+T Spectral Type
Ctrl+R Move serie
Ctrl+I Window Infos...
Ctrl+G Manage scale & graduations
Ctrl+Z Interactive zoom
Ctrl+L Spectra library
Ctrl+F Smoothing filter "Low-Pass"
Ctrl+C Copy
Ctrl+V Paste
Ctrl+B Paste format of the active profile
Ctrl+N Reference the continuum to 1

Alt+selection profil Zoom on selection
Ctrl + click sur série Automatic selection of line close by

Formules

Doppler: ΔV=c.Δλ/λ
Rep: Iobs/Itheo + Extraction continuum
Icorrinstru: Iobs/Rep
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Type T_{eff} log_g
O3V 52500 4.14
O5V 44500 4.04
O6V 41000 3.99
O5I 40300 3.34
O6I 39000 3.24
O8V 35800 3.94
O8I 34200 3.24
B0V 30000 3.9
B0III 29000 3.34
B0I 26000 2.84
B3V 18700 3.94
B5V 15400 4.04
B5III 15000 3.49
B5I 13600 2.44
B8V 11900 4.04
A0I 9730 2.14
A0V 9520 4.14
A5I 8510 2.04
A5V 8200 4.29
F0I 7700 1.74
F0V 7200 4.34
F5I 6900 1.44
F5V 6440 4.34
G0V 6030 4.39
G0III 5850 2.94
G5V 5770 4.49
G0I 5550 1.34
K0V 5250 4.49
G5III 5150 2.54
G5I 4850 1.14
K0III 4750 2.14
K0I 4420 0.94
K5V 4350 4.54
K5III 3950 1.74
K5I 3850 0.34
M0V 3850 4.59
M0III 3800 1.34
M0I 3650 0.14
M2V 3580 4.64
M2I 3450 -0.06
M5V 3240 4.94

Stellar Model Star Atmos file name coding
- 450 is for the temperature, 4500°K
- 45 if the gravity log(g)=4.5cm/s²
- k4 is the microturbulence velocity, 4km/s
- p00 is the metallicity ratio [M/H] which 0.0 for 
solar abundance or m05 for [M/H]=-0.5 for 0.32 
times solar abundance or p05 for [M/H]=0.5 for 3.2 
times solar abundance

 
This reference guide can be found on the website in a power-point format. 

Anotated diagrams 
All anotated spectra are from Christian Buil 
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Telleruc lines 6470-6590 
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Telluric lines 6500 - 6600 
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Neon spectrum 5800 - 7500 
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Vega spectrum 3800 - 8000 
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A P P E N D I X  2  
 

Buttons 

 
 
 

Principal Toolbar 
 

 Open a .pic or .fit image 

 Open Visual Spec Explorer 

 Open a .spc Profile file 

 Display a search window for all profiles which contain the search string 
 

Image Toolbar 
 

 Apply a new low threshold, new high threshold to the visualization image 

 Apply new thresholds to the visualization image 

 Reset the thresholds to default values 

 Mirror the image to revert the left-right side 

 Extract a spectral profile 

 Display a box to limit the binning on this area 

 Extract a reference profile 

 Export a sub-image to Excel 
 

Calibration Toolbar 
 
Display the list of lines of the reference element (Argon) 

 Display a dialog window for applying new thresholds in Y, in X 
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Continuum Toolbar 
 

 Toggle the method of calculation of the continuum between area-suppression mode and point-mode 

 Eliminate the selected area from the profile of the continuum 

 Reset the areas eliminated from the continuum 

 Execute interpolation of the continuum 

 Reinitialize the list of intake points of the continuum 

 Execute interpolation of the continuum by points 

 Leave continuum mode 

 Save the list of continuum points 
 

Profile Toolbar 
 

 Display a dialog window for applying new thresholds in X, in Y 

 Zoom on scale X of the profiles in the area selected using the cursor 

 Erase all displayed series 

One line calibration 

Two lines calibration 
Multi-lines calibration 

 Redimension the profile document to a predefined format 

 Cut the profil according to the selection 

 Copy the active series 

 Paste the series previously copied 

 Apply the X format of the active series to all windows 

 Display Element window 

 Normalize the active series 

Atmosphere spectrum correction 

Divide a profile by another profile 

 Display a dialog window to add a series containing a theoretical profile of the Planck temperature 

 Display a selection window of calculations to be carried out on a selected area 

 Replace one of the base series with the active series 

 Launch Gnuplot application 
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 Synchronise curseur on the profiles opened 

Button on the side of a profile document 
 Decrease the value of the upper bound of the Y axis  

 Increase the value of the upper bound of the Y axis 

 Lock the upper and lower Y axis boundes of the active serie to all the series 

 Apply the current Y axis scaling of the active serie to all the series 

 Among all series find the Y-max value and take it to scale all the series 
 Display graduated axis 

 Refresh the graphic display 

 Unzoom 

 Take a quick screen capture in a bmp format 

 Apply a validation scenario for BeSS spectrum 
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A P P E N D I X  3  
 

Reference list of menus and functions 

 

Visual Spec 
Menu Function Description 
File  Open image…  Open a .pic or .fit image 

  Sequence duration  Get a list of  the image files of a sequence to compute the overall exposure and 
time 

  Profiles Explorer  Open Visual Explorer interface to open profiles document 

  Open profile…  Open a .spc document 

  Find   Search for a .spc document whose header contains the search‐string 

  Quit  Quit the application 

Tools  Elements  Display the dialog box to search for element spectral lines 

  Console  Open the console to enter command‐line commands 

Assitant  0b_to_0c  Call the assistant for Lhires calibration: wavelength & response 

  1b_to_2b  Call the assistant for Lhires calibration: response, H20, continuum 

  Scriptbox  Call the scriptbox to run script on a list of documents 

  Run Spectrum  Launch Spectrum interface 

  BeSS query  Interface panel to query BeSS database 

  CDS query  Name enter box to query Simbad database 

Options  Preferences…  Display the Preferences dialog box 

?  About…  Display the window “About Visual Spec” 

  Help  Launch the Acrobat Reader to display the help file Aide.pdf 
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Image 
Menu Function Description 
File  Open profile…  Open a .spc document 

  Open image…  Open a .pic or .fit image 

  Display header  Display the header of the image file 

  Find references…  Search for an associated .pic image beginning with the prefix “a” 

  Export bmp  Export the Image document into a bmp file under name<‐I>.bmp in the same 
directory 

  Close  Close the current document 

  Close All  Close all image windows 

  Quit  Quit the application 

Window  Arrange  Cascade the windows 

  Mosaic  Tile the windows 

  Align  Align the windows at the left of the screen one over another 

Options  Preferences  Display the Preferences dialog box 

?  About…  Display the window “About Visual Spec” 

  Diagrams  Can display different spectral profile with lines indentified 

  Help  Launch the Acrobat Reader to display the help file Aide.pdf 

 

Profile 
 

Menu Function Description 
File  Open image…  Open a .pic or .fit image 

  Sequence duration  Get a list of  the image files of a sequence to compute the overall exposure and time 

  Profiles Explorer  Open Visual Explorer interface to open profiles document 

  Open profile…  Open a .spc document 

  Find…  Search for a .spc document whose header contains the search‐string 

  Save  Save the document without changing its name 

  Save As…  Save the document, asking for a new name 

  Export fits  Convert and export the .spc file into a fits 1D document 

  Export txt  Export the .spc document as a .txt document 

  Export bmp  Export the active window as a .bmp document 

  Close  Close the current document 

  Close All  Close all image windows 

  Quit  Quit the application 
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Edit  Copy  Copy the series 

  Paste  Paste the series 

  Apply format  Apply to all windows the X format of the active series 

  Clear  Clear the active series from the window 

  Suppress  Suppress the active series from the list, if it is a temporary series 

  Replace  Dialog box: replace one of the predefined series with the active series  

  Crop  Eliminate areas outside the selected area from the active series 

  Pixel…  Dialog box: edit the intensity of the pixels 

  Header  Dialog box: edit the .spc document Header 

Format  Graphic…  Dialog box: Modify the graphic format, scale and graduations 

  Zoom…  Interactive zoom and translation controls 

  Line  Display the spectral profile as a line 

  Dot  Display each pixel with a symbol 

  Bar  Display the spectral profile in a small rectangle 

  Font…  Dialog box: Modify the font of the Graph 

  Background color  Dialog box: Modify the color of the graphic background 

Operations  Normalize  Normalize the series with respect to a predefined continuum 

  Divide profile by a 
profile… 

Divide the active series by a series in memory 

  Multiply profile by a 
profile … 

Multiply the active series by a series in memory 

  Add profile by a profile 
… 

Add the active series to a series in memory 

  Subtract profile by a 
profile … 

Subtract the active series from a series in memory 

  Recalibrate profile by a 
profile 

Recalibrate the active series based on calibration of a series in memory 

  Binning 1:2 horizontal  Digital binning: add the intensities of 2 adjacent pixel 

  Operations with 
values... 

Dialog box: Arithmetic operations with constant 

  Suppress zone  Exclude temporary a spectral zone for a computation 

  Translate…  Dialog box: Translate series in X 

  Join  Concatenate two series to form one series 

  Compose  Add the displayed profiles to the active series 

  Low‐Pass Filter  Dialog box: apply a low‐pass filter 

  Spline Filter  Dialog box: apply a spline filter 

  Gaussian Filter  Dialog box: apply a gaussian filter 

  MMSE Filter  Dialog box: apply a mmse filter 
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Spectrometry  Calibration 1 lines…  Display the  one line calibration toolbox  

  Calibration 2 lines…  Toolbar: manual calibration based on instrumental parameters 

  Calibration multi‐lines 
lines… 

Dialog box non‐linear calibration  

  Computation 
preferences 

On a selection of lines, dialog box: measurement 

  Heliocentric correction  Dialog box: compute the heliocentric correction due to the Earth moving 

  Heliocentric speed 
correction 

Dialog box: apply the heliocentric speed correction 

  Gaussian fit  Fit a Gaussian curve on the selected region 

  Fit Photosphere  Dialog box: Adjustement and subtraction ofa gaussian profil to suppress the 
photospheric contribution (Work in Progress…) 

  Resampling  Dialog Box: resample the profil 

Radiometry  Compute Continuum…  Display the Continuum toolbox to compute the continuum 

  Extract  If list of wavelength is not empty, extract the continuum from this list 

  Extract from zone list  If list of wavelength region to exclude is not empty, extract the continuum 

  Auto continuum  Automatic detection of continuum 

  Continuum division  Call the function Continuum then replace the intensity series by its division by a 
continuum 

  Continuum subtraction  Call the function Continuum then replace the intensity series by its substraction by a 
continuum 

  H20 correction  Dialog box: suppress the atmospheric lines of the water 

  H20 correction real 
spectrum… 

Dialog box: select the atmospheric profile then link with the intensity adjustment dialog 
box 

  Auto Planck  Dialog box: compute the best fit of planck curve varying the temperature 

  Planck…  Dialog box: calculate the Planck profile for a temperature 

  Extinction  Dialog box: correct the atmospheric extinction 

  Compute flux of 
reference star… 

Dialog box: Calculate the instrumental response for a reference star 

  Absolute Flux 
calibration 

Correct the active series from the instrumental response 

Tools  Elements…  Dialog box: display the database of elements 

  Library…  Dialog box: display the database of standard spectra 

  Spectral type  Dialog Box: search for the spectral type of a star 

  Coordinates  Dialog Box: search for coordinates of a star 

  Run GnuPLot  Dialog Box: launch the GnuPLot application 

  Comparison  Dialog box: format parameters to be applied to all opened profiles 

  Page...  Dialog box: parameter for the web page generation with the gnuplot graphs of the 
opened profiles 

  Stack and Shift Y...  Dialog box: parameters to stack all the profiles series on the same graph with an offset 
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along Y axis 

  Label  On the selection of lines and calibrated profile: display the wavelength 

  Synthesis  Display the spectral image reconstructed from the active series 

  Animation  Dialog box: temporal animation of the displayed profiles 

  Console  Display the command‐line window 

  Infos…  Display the calculation windows on the lines 

Assitant  0b_to_0c  Call the assistant for Lhires calibration: wavelength & response 

  1b_to_2b  Call the assistant for Lhires calibration: response, H20, continuum 

  Run Spectrum  Launch Spectrum interface 

  BeSS query  Interface panel to query BeSS database 

  CDS query  Name enter box to query Simbad database 

Window  Small windows  Reduce the set of windows to “thumbnail” size 

  Adjust  Enlarge the set of windows to normal size 

  Arrange  Cascade the windows 

  Tile  Tile the windows 

  Align  Align the windows at the left of the screen one over another 

Options  Preferences  Display the Preferences dialog box 

?  About…  Display the window “About Visual Spec” 

  Diagrams  Display a list of spectra with lines identified 

  Help  Launch the Acrobat Reader to display the help file Aide.pdf 
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Translation Notes 

 
The translator of this document is not export in either spectroscopy or French/English translation.  
Mistakes are undoubtedly present.  If something seems wrong, the user may find that a better 
translation will provide better help. 

 
Some useful French-English vocabulary: 
 

La longeur d’onde = wavelength 

Raie = line (spectral line) 

Étalonnage = calibration 

Calibrer = gauge 

Repartition = distribution 

Recaler = readjust 

Decaler = shift 

Affiché  = displayed 

Bascule = toggle 

Seuil = threshold 

Onglet = tab 

Cocher = check (a checkbox) 

Enregistrer = save (record) 

Visualiser = view 

Decalage = shift 

Barycentre = barycenter 

Pose = exposure 

 

A useful site for translating words and phrases (don’t forget that human language does not follow 
strict syntax, so automatic translation is not completely reliable): 

http://translator.go.com/ 
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